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 Abstract  

INTRODUCTION: The combination of time spent in physical activity, sedentary behaviour, 

and sleep within a day is known as the 24-hour movement behaviour composition. Recent 

research using compositional data analysis (CoDA), a branch of statistical analysis appropriate 

for compositional data, such as the 24-hour movement behaviour composition, has identified that 

the 24-hour movement behaviour composition is an important determinant of health. The 

potential for the physical features of a person’s neighbourhood environment to promote healthy 

movement behaviours has also been identified. However, research has not yet considered which 

neighbourhood environment features are associated with all components of the 24-hour 

movement behaviour composition. The objective of this thesis was to use CoDA to identify 

neighbourhood physical environment features that are associated with the 24-hour movement 

behaviour composition among children. 

METHODS: 458 children aged 10-13 years from Kingston, ON, were studied. Neighbourhood 

physical environment features were measured in 1 km buffers from the participants’ homes 

using geographic information system (GIS) software and databases. Twenty-three 

neighbourhood environment characteristics were measured, and from these, six indices were 

created, including walkability, traffic safety, dedicated play and activity spaces, non-dedicated 

play and activity spaces, noise, and artificial light. Moderate-to-vigorous physical activity, light 

physical activity, sedentary time, and sleep duration were measured over seven days using 

accelerometers and sleep logs. CoDA was used to establish differences in the movement 

behaviours between groups defined by the neighbourhood physical environment features. 

RESULTS: A total of 29 associations between neighbourhood environment features and 

movement behaviours were examined and only three exposures had statistically significant 
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differences in movement behaviour compositions. All three significant associations were for 

non-dedicated play and activity spaces. These significant results included subtle differences, did 

not follow dose-response patterns, and were not always in the expected direction.  

CONCLUSIONS: Neighbourhood physical environment features were not meaningful 

correlates of 24-hour movement behaviours. 
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Chapter 1 

Introduction 

1.1 General Overview 

Time spent in movement behaviours, including sleep, sedentary behaviour (SED) (e.g., 

sitting), light-intensity physical activity (LIPA) (e.g., standing, walking slowly), and moderate-

vigorous physical activity (MVPA) (e.g., running, biking) adds up to 24-hours a day. The 

Canadian 24-hour movement guidelines for children and youth recommend 9-11 hours of 

uninterrupted sleep, restricting recreational screen time to no more than 2 hours, and engaging in 

at least 60 minutes of MVPA per day to obtain health benefits.1 Canadian children continue to 

struggle to meet these recommendations. According to the recent national statistics for Canadian 

children and youth, 70% meet the sleep duration recommendation, 38% of children and youth 

meet the screen time recommendation, and 39% meet the MVPA recommendation.1,2 

Furthermore, less than 20% of 5-17 year-old Canadians meet all recommendations.1,2 Not 

meeting these recommendations is associated with a multitude of physical, psychological, social, 

and cognitive health indicators.3–5 

Much of past research on the health benefits of movement in children has focused on the 

benefits of MVPA.6 However, MVPA usually accounts for <5% of total time in a child’s 24-hour 

day.7 The health relevance of LIPA, SED, and sleep, which make up the remaining 95% of the 

day, has been recognized.8,9 The relative proportions of each of these behaviours in the 24-hour 

day is known as the 24-hour movement behaviour composition, which has recently been deemed 

more important for overall health than assessing time spent in any individual movement 

behaviour.10,4 
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To change the projection of children and youth meeting the collective 24-hour movement 

guidelines, studying the determinants of these behaviours is important. Identifying these 

determinants could help inform future interventions, planning, and policies designed to benefit 

children’s movement behaviours. There are multiple levels of influences at play when 

determining someone’s health behaviours. These can be described through an ecological model, 

which illustrates how people interact with their surroundings.11 The levels include intrapersonal 

(biological, psychological), interpersonal/cultural, organizational, physical environment (built, 

natural), and policy (laws, rules, regulations, codes) variables, which move from most directly to 

most indirectly affecting the person’s behaviours.12 The neighbourhood where someone lives 

would fall under the physical environment level, which has been determined one of the most 

important levels to tackle when it comes to active living and influencing behaviours at a 

population level.12  

Past research has determined that a child’s physical neighbourhood environment can 

influence their movement behaviours. Aspects like street network design and access and 

availability of parks are associated with physical activity,13,14 the presence of sport and recreation 

facilities15 and cul-de-sacs16 can impact SED, and surrounding noise and artificial light can affect 

sleep.17,18 A significant number have examined the association between the neighbourhood 

environment and physical activity,13,19 SB,16,20 and sleep21,22 on their own; however, there is a 

gap in the research when it comes to considering how neighbourhood environment features are 

associated with the collective 24-hour movement behaviour composition.  

When conducting statistical analyses on the 24-hour movement composition and its 

relation to the neighbourhood physical environment, it is important to consider the compositional 

nature of the daily movement behaviours. Movement behaviours are finite and co-dependent 
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variables, meaning that they add up to the full 24-hour day, and changing time spent in one 

behaviour will affect some combination of the other behaviours in an equal and opposite manner. 

For instance, adding one hour/day of SED would subsequently decrease sleep or physical activity 

or some combination of the two by one hour.23 Traditional statistical analyses, such as standard 

regression analyses, assess movement behaviours independently and consider them to be 

continuous and occurring in standard Euclidean space (from - ∞ to + ∞). Compositional data do 

not occur in Euclidean space but rather in a subset of real space called the simplex, which can 

only add up to the constant sum of 24 hours. Not considering these characteristics of 

compositional data can cause spurious findings among traditional statistical approaches.24  

Compositional data analysis (CoDA) is a branch of statistical techniques that can deal 

with data that is a composition of a finite whole, like the 24-hour movement behaviours.23 It was 

traditionally used in geosciences, nutrition, and chemistry,25 but the health and epidemiology 

field has recently recognized and adopted the approach. CoDA eliminates co-dependence issues 

among the behaviours and allows data to be entered in traditional statistical analyses by 

transforming the data to occur in standard Euclidean space.25 

1.2 Objectives and Hypothesis 

The objective of the research presented in this thesis is to use CoDA to identify differences 

in 24-hour movement behaviour components among children based on neighbourhood physical 

environment features. It is hypothesized that having the highest access and availability of play 

and activity spaces will be favourably associated with the 24-hour movement behaviours.  
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1.3 Scientific and Public Health Significance 

Urban planning and development processes are in part informed based on public health 

interests. Research evidence based on studies that examined individual movement behaviours, 

like increasing physical activity through cycling lanes, are common. However, it is essential to 

consider whether aspects of the neighbourhood environment will favour all movement 

behaviours and not just one. It is important to employ a more holistic and comprehensive 

approach to addressing movement behaviours in the physical environment rather than isolated or 

specific interventions. Further, many environmental factors have been found to affect adults' 

behaviours, such as walkability and active transportation,26 but less is known about how they 

affect children.27 Therefore, this study can contribute to furthering this knowledge base. This 

research could inform future planning strategies and public health guidelines by identifying the 

neighbourhood environment's modifiable features that affect the full movement behaviour 

composition of children. 

1.4 Thesis Organization 

This thesis is organized in accordance with the guidelines for a manuscript-based thesis 

provided by the School of Graduate Studies at Queen’s University. The first chapter gives a 

general overview of the main subject area of this thesis. The second chapter includes a literature 

review consisting of the neighbourhood environment and its components found to be associated 

with one or multiple movement behaviours. The statistical methods applied to the movement 

behaviour data are also discussed. The third chapter is the manuscript, which investigates 

differences in movement behaviour compositions between levels of neighbourhood physical 

environment exposures. The fourth chapter is a general discussion that summarizes key findings, 

strengths and limitations, public health implications, and future directions of the research. 
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Finally, several appendices are included at the end of the document to cover methodological 

details not elaborated on in the manuscript. 
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Chapter 2 

Literature Review  

2.1 Introduction 

The purpose of this literature review is to provide an overview of the associations between 

neighbourhood physical environment features and movement behaviours within school-aged 

children. The review begins by including definitions of key terms and concepts, discussing the 

differences in measurement type, and defining what a neighbourhood is and differences between 

different types and sizes of boundaries that can be used to measure a participant’s 

neighbourhood. Then, I provide information on and assess the literature concerning the various 

physical environment features that are associated with one or multiple movement behaviours. 

Some background information is also provided on compositional data analysis (CoDA), the 

complex branch of statistical analysis techniques used in this thesis.  

2.2 Definitions of Key Terms and Concepts 

This thesis will focus on children but will also frequently mention youth, adolescents, and 

adults. There is no universally accepted definition of children, but many refer to a child as 

anyone under the age of 18, which is how a child will be defined throughout the thesis. As for 

youth and adolescents, there is some overlap, as WHO refers to youth as 15-24 years old and 

adolescents as 10-19 years.1 Adult will be considered anyone aged 18 or older.  

Measurement of various movement behaviours will often come up throughout the thesis. An 

accelerometer can be used to measure the behaviours objectively. They measure both physical 

activity and sedentary behaviour by converting a physical force to an electrical charge. They are 

considered the gold standard in physical activity measurement in field or natural settings. 
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Movement behaviours are also often categorized based on metabolic equivalents (MET). One 

MET is equal to the quantity of oxygen consumed while at rest.2 

The different movement behaviours mentioned throughout this thesis include sleep, 

sedentary behaviour, and physical activity. In this thesis, sleep duration is considered the time 

spent in bed. Sedentary behaviour refers to waking activities that expend ≤1.5 METs while in a 

sitting or reclined position.3 Sedentary behaviour is made up of both non-screen based 

behaviours (e.g., doing homework, reading, passive transport) and the more frequently assessed 

screen-based activities (e.g., TV viewing, playing video games, computer use).3 Physical activity 

encompasses “any bodily movement produced by skeletal muscles that requires energy 

expenditure”.4 Total physical activity refers to all physical activity throughout a whole day. 

Physical activity can also be broken down into light-intensity physical activity (LIPA) and 

moderate-vigorous physical activity (MVPA). LIPA includes activities within the intensity range 

of 1.6-2.9 METs and comprises activities such as light walking and activities of daily living (e.g., 

standing, cooking, getting dressed).5 MVPA refers to activities requiring ≥3 METs and includes 

activities such as brisk walking, playing sports, and running.5 Physical activity can also be 

assessed by domain. Different domains include active transportation or commuting, which 

consists of any method of travelling “using your own power to get from one place to another” 

such as walking, biking, skateboarding, etc.6 Other domains include organized sports and 

programs, curriculum-based physical activities at school, and active play.7 

Geographic Information Systems (GIS) can be used to measure components of the 

neighbourhood environment objectively. GIS is computer-based software, hardware, and data 

that allows us to visualize, analyze, and interpret geospatial data to understand relationships, 

patterns, and trends.8 Within GIS and other databases, many neighbourhood components were 
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considered in this thesis. Walkability refers to how well a neighbourhood promotes active forms 

of transportation, such as walking.9 This measure consists of street connectivity, proximity to 

destinations, and pedestrian safety and infrastructure. Street connectivity is a measure of road 

length, intersection density (i.e., number of intersections per km2 of land area), average block 

length (i.e., length of roads/number of true intersections), and connected node ratio (i.e., ratio of 

intersections to all nodes including cul-de-sacs). Proximity to destinations involves distance to 

school, population density per square km of land area, and Walk Score®. Walk Score® is an 

algorithm that awards points based on the distance from the home to the closest amenity in each 

category, such as businesses, parks, schools.11 Pedestrian safety and infrastructure includes total 

length of sidewalks, estimated traffic volume, and density of traffic calming measures.10 

Dedicated play and activity spaces is another measure that includes areas devoted to movement 

and activity, and they encompasses both sport and recreation facilities. Throughout this thesis, 

sports facilities refer to arenas, courts, tracks, and fields dedicated to sport and where 

competition may typically occur. Recreation facilities include other physical activity facilities 

such as skate parks, driving ranges, play structures, swimming pools, and batting cages, where 

competition does not necessarily take place. Physical activity facilities would comprise both 

sport and recreation facilities together. Non-dedicated play and activity spaces refer to areas not 

necessarily devoted to movement and activity, which includes parks, non-park greenspace, 

average yard size, and cul-de-sacs. Parks are developed, multi-purpose green areas. Non-park 

greenspace includes un-developed greenspace such as treed areas and meadows. Average yard 

size is a measure of residential land area minus residential building area divided by the total 

number of residential properties. Cul-de-sacs are short no-exit roads with a large, circular area at 
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its end. The cul-de-sac measure refers to the amount within the surrounding area of the home 

address.  

2.3 Differences in Measurement 

When measuring both movement behaviours and physical neighbourhood environment 

features, the measures can be collected either objectively or subjectively. Objective measures are 

impartial and result in quantifiable outcomes recorded by an instrument of sorts. These include 

the use of pedometers, inclinometers, accelerometers, environmental databases, and GIS. 

Subjective measures are when human judgement or opinion is considered. Subjective measures 

include questionnaires, interviews, and diaries/logs. Apart from using sleep logs, which are more 

accurate than questionnaires as they are less likely to have recall errors, our study encompasses 

only objective measures of the movement behaviours and environmental features. These include 

gold standards in measurement and can help eliminate sources of bias. However, using only 

objective measures may lead to missing out on context-specific movements or specific 

movement domains, such as active transportation, which are highly associated with 

environmental attributes.12 Also, an important component of determining behaviour is taking 

people's perceptions of their environment into account. Understanding an individual's interaction 

with the environment is just as important as measuring the environment itself.13 Just because an 

environment is objectively safe, easily walkable, or free from significant noise or light sources 

does not mean that someone will perceive their environment in this way.  

2.4 Defining the Neighbourhood 

Galster14 defines a neighbourhood as “the bundle of spatially based attributes associated with 

clusters of residences, sometimes in conjunction with other land uses.” Whether it be 
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characterized based on environmental, structural, socioeconomic, or other factors, spatial 

features are often used to determine a neighbourhood’s boundaries.  

Neighbourhood boundaries can be based on predefined social or political boundaries or 

buffers that radiate from an individual’s home.15,16 Examples of predefined administrative 

boundaries include census tracts, dissemination areas, or postal codes. Census tracts are defined 

as reasonably stable geographic regions within a census metropolitan area, and they typically 

have a population between 2,500 and 8,000 persons.17 Dissemination areas are smaller 

geographic units within a census tract comprised of 400-700 people, primarily formed from road 

network boundaries, and they cover all of Canada.18 Everyone living in these areas is placed into 

the same neighbourhood and would be assigned the same values for the neighbourhood features. 

These predefined boundaries can make up large areas that may not include much of the actual 

home’s surrounding area and cause false representations of the participants’ physical 

environment exposures.19  

On the other hand, buffers consist of areal units of a certain threshold distance or radius 

surrounding the subject’s address.16 Creating a buffer around each participant’s home address 

provides a more precise measurement of their surrounding environment than census tracts or 

postal codes. Everyone has a distinct neighbourhood based on their specific address and would 

be assigned their own values for neighbourhood features. The two most common types of buffers 

used are Euclidean and road network buffers, which can be constructed using geographic 

information systems (GIS). Euclidean buffers, also known as “as the crow flies” or “circular” 

buffers, are precisely that - a radius of a set distance around a central point such as a home.20 

Road network buffers also reflect the distance from a centroid; however, these buffers are based 

on distances that can be traveled by streets, public transportation, or walking/cycling paths, 
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which can change the perspective of what is accessible in the neighbourhood quite 

significantly.15,20 A network buffer takes into account barriers to the straight-line distance to a 

destination, such as buildings and natural obstacles like bodies of water.20  

The buffer sizes used to define the neighbourhood boundaries vary considerably from study 

to study and have ranged from 50 metres to 8 kilometres or more, depending on what features the 

researcher wants to assess.20–23 Also, the appropriate size of the buffer may differ according to 

the age-group. Specifically, smaller buffer sizes may be more suitable when defining the 

neighbourhood for a child versus an adult because most children have a limited independent 

mobility (i.e., the distance in which they can roam from their home unsupervised).15,24 Many 

studies have used a 1-km buffer distance for children. A 1-km distance is close to the average 

independent mobility range and is a comfortable 10-15 minute walking distance.24  

Figure 2.1 demonstrates the differences between using a census tract boundary, a 1000m 

network buffer around the census tract centroid, and a 1000m network buffer around the actual 

address when trying to determine accessibility to grocery stores.16 The census-tract boundaries 

would classify the address as being near one grocery store, when in fact, the actual address is in 

the proximity of three grocery stores. The same issue may arise when participants live near the 

border of their particular administrative boundaries but spend most of their time in another. 

These positional discrepancies are worse in small towns and rural areas when using address 

proxies, especially when the buffer threshold distance is less than or equal to 500m.16  



 

16 

 

 

Figure 2.1 Misclassification due to different neighbourhood boundaries (from Healy & 

Gilliland16) 

 

 

2.5 Neighbourhood Physical Environment Features and Movement Behaviours 

2.5.1 Walkability 

According to Public Health Ontario9, walkability is “a measure of how well a 

neighbourhood promotes active forms of transportation, such as walking,” and it has been 

proposed as a key factor in making communities efficient, accessible, equitable, and 

sustainable.25 Walkability encompasses more than just one component of the physical 

environment, and varying features have been considered during its measurement.26–28 A study of 

10-13-year-old children from Kingston created a walkability index based on several physical 

environment features that captured street connectivity, proximity to destinations, and pedestrian 

safety and infrastructure.10  

It is well recognized that walkability is positively associated with physical activity in 

adults.29 If neighbourhood streets are well-connected and residents live close to services, shops, 
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parks, and public transport, adults are more likely to actively commute to these places, increasing 

their total physical activity.29 However, studies conducted with children and youth have shown 

mixed and inconsistent results regarding walkability and physical activity. This may be because 

the specific type of physical activity being measured among children and youth can influence its 

association with walkability. For instance, active transportation was positively associated with 

objectively measured walkability scores in some studies.10,30,31 However, another measure of 

physical activity, such as steps per day, was negatively related to walkability levels in a study 

with Belgian adolescents.32 Neighbourhoods with high walkability may only contribute to 

physical activity related to active transportation; therefore, assessing walkability’s association 

with MVPA or total physical activity among children and adolescents may not be as relevant. 

Studies considering how walkability affects all ages simultaneously are lacking in the literature.  

Many studies have considered individual components of walkability and their associations 

with physical activity. Proximity to destinations, such as the child’s school, is a component of 

walkability found to have positive associations with active transportation measures. For instance, 

a study of 12-15-year-old students found that for every additional kilometre they lived from 

school, they were 43% less likely to report occasional (1-4 trips per week) and 76% less likely to 

report habitual (5-10 trips per week) active school travel.33 Living closer to school would 

encourage more active transportation among children. Another component of walkability is street 

connectivity. Street connectivity is a measure of how well streets connect to each other and the 

density of intersections, with a highly connected neighbourhood having short links, many 

intersections, and few cul-de-sacs and dead ends.34 The same study of the 12-15-year-old 

students also looked at street connectivity. They determined that objective street connectivity 

was negatively associated with active trips to school (OR: 0.98, 95% CI: 0.95 to 1.00); whereas, 
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perceived street connectivity was positively related to active trips to school (OR: 1.88, 95% CI: 

1.05 to 3.36).33 This difference may be due to what was being measured in both instances. 

Objectively, street connectivity was measured as intersections/km2, while the perceived measure 

asked if the streets in their neighbourhood had dead-ends or cul-de-sacs and if there were many 

different ways of getting from place to place. It is worth noting that this study only included 

students who lived within two miles of their school, so this could affect the generalizability of 

the results. Another study has also supported the objective street connectivity finding by 

comparing after-school hours of physical activity in youth living in neighbourhoods with varying 

street connectivity. They found that youth living in neighbourhoods with higher street 

connectivity were less likely to engage in physical activity.34 Although, this study used an 

anonymous survey that impeded knowing the students' exact addresses, so the home 

neighbourhoods of each participant were 5-km radius buffers around their school as a proxy. 

This proxy measure might have led to some misclassification of participants' neighbourhood 

connectivity exposures if they did not live within 5 km of their school. Despite this limitation, 

these street connectivity findings are possibly explained by the higher traffic levels in more 

connected areas, causing safety concerns. Also, the more urban areas with the highest 

connectivity are densely populated, with homes all very close together, allowing little room for 

yards and driveways to play in.34 However, both of these studies were cross-sectional; therefore, 

limiting any causal inferences. Additional research clarifying the role of street connectivity for 

physical activity in youth, especially between objective and perceived measures, is needed.  

Research has also considered whether neighbourhood walkability is related to sedentary 

behaviour. It was found that grade 7-12 students who lived in walkable inner-city developments 

had a 12% higher risk of exceeding 2 hours/day of screen time by comparison to students who 
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lived in non-walkable suburban developments after adjusting for parental education, household 

income, race/ethnicity, and age of the adolescent.35 This finding may be due to other social 

influences often present in inner-city, low socioeconomic status (SES) neighbourhoods, such as 

perceptions of safety and crime or lack of parental influence on the child’s activities. In another 

study, parents from Kingston, Ontario, reported their pre-school-aged children’s daily screen 

time.36 After adjusting for multiple sociodemographic factors, walkability was not associated 

with young children’s parent-reported screen time. The contrast of the ages of the children being 

studied between the Nelson et al.35 and Carson et al.36 studies may contribute to important 

differences in the results. Older children tend to spend more time using screen-based devices and 

are more influenced by their neighbourhoods’ walkability. Further, both studies used reported 

screen time as a measure of sedentary behaviour, which may include risk of recall or social-

desirability biases, as well as neglecting to measure other types of sedentary time. Employing 

objective measures, such as accelerometers, to assess sedentary time is important to gain a 

clearer picture of how much time is spent inactive.    

Limited research has examined the associations between walkability and sleep. One of 

the few studies of this topic area examined whether access to sidewalks and walking paths in the 

neighbourhood was associated with sleep among American children aged 6-17 years.37 Sleep 

problems were assessed through parents answering the question “During the past week, on how 

many nights did the child get enough sleep for a child his/her age?” Inadequate sleep was 

categorized into less than five days per week or less than seven days per week. There was no 

statistically significant association between neighbourhood access to pedestrian infrastructure 

and sleep after adjusting for covariates. However, the study's measures were parent-reported, 



 

20 

 

which may have introduced some parental bias and inaccurate reflections of sleep measures or 

neighbourhood environment ratings, especially among the adolescent participants. 

2.5.2 Traffic Safety 

Variables that reflect neighbourhood traffic safety, such as traffic calming (e.g., speed 

humps and low-speed zone signs), traffic volume, traffic speed, and pedestrian infrastructure 

(e.g., sidewalks and walking paths) are associated with individual movement behaviours. A 

review of the built environment and physical activity noted that slower traffic speeds alongside 

sidewalks promoted higher physical activity levels among youth and adults.38 Another review 

found that perceived and objectively measured road hazards, such as the number of roads to 

cross, road barriers, and traffic speed and density, were all negatively related to children’s 

physical activity.39 Although, 31 out of the 33 studies included in the review were cross-sectional 

studies making it hard to determine causation.39 Various studies have found that both parent and 

child-perceived concerns about neighbourhood and road safety have been negatively associated 

with outdoor play time and moderate-vigorous physical activity (MVPA).40,41  

One of the first studies to assess associations between objective measures of pedestrian 

traffic safety in the neighbourhood and outdoor active play was conducted in Kingston with 10-

13-year-olds.42 They found some significant associations; however, the results were not 

consistent, had weak associations, did not display a dose-response relationship, and were based 

on cross-sectional data, so causality was unlikely. These results were inconsistent with much of 

the previous literature on traffic safety and physical activity. The inconsistency may reflect that 

Kingston is a less populated city with considerably less traffic than the cities where previous 

studies were conducted (e.g., Toronto, Melbourne, San Diego). When looking at pedestrian 

infrastructure as a specific traffic safety and walkability component, a study of Dutch 10-12-
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year-old children considered its relationship with objectively measured after-school physical 

activity. Pedestrian infrastructure, such as walking and cycling paths, was related to greater 

leisure time MVPA (β (SE) = 0.05 (0.01), p <0.05) and bicycling (β (SE) = 0.06 (0.01), p <0.05) 

in the sample.43 Although these are relatively small effect sizes, this study used global 

positioning system (GPS) loggers to provide more context to the movement and only considered 

leisure-time physical activity and active transportation. This allowed for filtering out other 

physical activity like organized sports, which often confound the relationship between physical 

activity and the surrounding environment.43  

The association between traffic safety variables and sedentary behaviour is not as well 

documented as physical activity. In a 2015 systematic review on the determinants of sedentary 

behaviour in youth, only one study looked at traffic safety variables in relation to sedentary 

behaviour.44 They found that none of the neighbourhood traffic safety measures, such as traffic 

volume and presence of sidewalks and walking/biking trails, were significantly related to either 

the cross-sectional or longitudinal levels of non-school sedentary behaviour of girls from grade 6 

to 8.45,46 Therefore, intrapersonal or interpersonal factors may be more at play than 

neighbourhood factors for this group. However, the neighbourhood measures were self-reported, 

which may have introduced recall bias. There was also some loss to follow-up between data 

collection periods leading to selection bias and loss of generalizability. Finally, the relationship 

between traffic safety measures and sleep has not been well-studied in children and youth.  

2.5.3 Dedicated Play and Activity Spaces 

The availability, accessibility, and proximity of spaces and facilities that are dedicated to 

play and activity may influence movement behaviours. Some of the spaces and facilities 

dedicated to children’s physical activity include arenas, recreation centres, playgrounds, and 
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sports fields. The association between sport and recreation facilities and physical activity has 

been examined in several studies. In one of the earliest studies of this topic, it was reported that 

having more physical activity facilities within a census block was associated with higher odds of 

engaging in ≥5 bouts of MVPA per week amongst adolescents. Having just one facility increased 

the odds by 3% (OR: 1.03; 95% CI: 1.01 to 1.06) and having seven facilities increased the odds 

by 26% (OR: 1.26; 95% CI: 1.06 to 1.50).22 This may be due to the facilities’ proximity, 

allowing adolescents to actively travel there and back, and once there, participating in sports and 

play. Two reviews looking at the association of dedicated play areas and physical activity 

outcomes determined a positive association in the majority of studies assessed (60% and 71%, 

respectively).39,47 However, both of these reviews included mostly self-reported or observed 

physical activity and active transportation data, therefore leading to potential recall or observer 

bias. Conversely, other studies found null or negative associations between dedicated play and 

activity spaces and MVPA. A review found that the availability and accessibility of physical 

activity facilities were consistently unrelated to physical activity among 3-18-year-olds.48 

Another study also found that self-reported MVPA levels were not related to the presence of 

recreational facilities, including developed parks and playgrounds, among a national sample of 

11-13-year-olds.49 These authors speculated that this null funding might have been explained by 

the fact that most of the particular parks and playgrounds they measured using GIS were 

relatively small (< ½ acre) and, therefore, had insufficient space for this age-group to run around. 

Moreover, the aspects of typical neighbourhood playgrounds such as monkey bars, swings, 

slides, and other play equipment, may not be as suited for pre and early adolescents as they 

would be for young children.26 It was also suggested that proximity and availability of these 

locations may not be what is most important to adolescents, but more so the quality of the 
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facilities and fees associated with using them.50 Additionally, Janssen and Rosu49 suggested that 

recreation facilities are more important at the greater community level than at the 1-km 

neighbourhood buffer level. Children and adolescents are often driven outside their 

neighbourhoods to get to their organized sport and program activities somewhere else in their 

municipality. 

As for the association between recreation facilities and sedentary behaviours, a study 

assessed children in both urban and rural settings. It was determined that those who had the 

greatest access to parks and playgrounds and recreational facilities in their neighbourhoods were 

less likely to engage in excessive screen time compared to those with the least access to these 

facilities (OR = 0.72, 95% CI = 0.62; 0.84) and (OR = 0.64, 95% CI = 0.55; 0.75), respectively.51 

Having the availability of parks and playgrounds nearby could entice children to travel there and 

displace time otherwise spent at home on screens. However, the screen time data was reported by 

parents of the children, which introduced some recall bias. As well, the survey only asked to 

report on the “access” of parks and playgrounds, which does not account for if the children use 

the parks regularly. Other studies found similar results; however, when stratifying by gender, 

they observed gendered associations. Both Roemmich et al.52 and Cabanas-Sánchez et al.53 noted 

that having recreational facilities near children’s homes was associated with less reported TV 

watching among boys but not girls. Further, a study conducted on the objectively measured 

sedentary behaviour of grade six females in various US schools found no significant results 

associated with access to physical activity facilities.46 However, they only assessed if the girls 

could easily travel to these facilities and did not ask about other details such as aesthetics, safety, 

cost, and age-appropriate offerings to determine if they actually went to these places. This 

question format may have introduced non-differential misclassification that could bias results 
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toward the null. Despite the differences in the measurement styles of these constructs throughout 

the studies mentioned above, they do have somewhat of a pattern of the distinction between boys 

and girls, as perhaps the presence of sport and recreation facilities is associated with the 

sedentary behaviour and screen time of boys to a greater extent than girls. 

Sleep has also shown to be related to sport and recreation facilities in children and youth. 

A study of children aged 6-17 years determined, after adjusting for covariates, that those who 

had the least access to amenities, such as recreation or community centres, were more likely to 

get inadequate sleep (OR: 1.37, 95% CI: 1.10, 1.70) by comparison to children who lived in 

neighbourhoods with the highest access to these amenities.37 However, this study only assessed 

sleep through one parent-reported question about adequacy, so other sleep components such as 

quality, duration, and diagnosed sleep problems were not included. Also, this study used data 

from the US National Survey of Children’s Health, which is known to have lower response rates 

from low SES and ethnic minorities which may have imposed a differential non-response bias on 

the results. Another study assessed the relationships between access to recreation facilities close 

to the home and sleep in adolescents and noted that greater access was related to longer sleep 

duration, later wake time in the morning, and greater sleep efficiency. Then again, it was also 

determined that physical activity was a mediating factor between access to facilities and sleep.54 

2.5.4 Non-Dedicated Play and Activity Spaces 

2.5.4.1 Greenspace 

Children can be active in multi-use spaces that can be used for a variety of purposes in 

addition to physical activity. One such space is greenspace. Greenspace is a term used in 

multidisciplinary research and has been implemented in many contexts without a consensus on 

the exact definition.55 Richardson et al.56 define it as any natural area, such as parks, beaches, 
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and fields, but not including marine areas or private gardens. Another group57 refers to it as 

simply “recreational or undeveloped land.”  

When looking at the relationship between greenspace and physical activity, it was noted 

that when useable, safe, and public greenspaces are within 0.3 to 0.5 kilometres radius from 

where someone lives, it promotes physical activity as well as overall health and well-being in 

people of all ages around the world.38 Moreover, a small but positive and significant association 

was found among Dutch children’s reported physical activity and the proportion of greenspace in 

the neighbourhood when adjusted for age, sex, body mass index, and maternal education (β = 

0.075, 95% CI: 0.024, 0.125).58 When greenspace is close and accessible, it may be more likely 

to be used for outdoor physical activity. There is little research specifically looking at the 

associations of undeveloped greenspace in the neighbourhood, such as wooded areas and 

meadows, and physical activity. Of those few studies, there have been mixed results. A study of 

11-15-year-olds from across Canada did not find any significant associations between wooded 

areas and physical inactivity.26 In another study of Canadian, urban residing 11-13-year-olds, 

meadowed areas were not related to the children’s free-time outside of school physical activity; 

however, treed areas were positively associated with the physical activity outcome.49 It is 

important to note that over 20% of the participants did not live within a 1-km distance to treed 

areas, so policies that protect existing treed areas will be important to enact for children’s 

health.49 This age group most likely uses these types of play areas more than typical developed 

areas like playgrounds, as the children have increased independence and these areas can be more 

diverse and stimulating.59 Therefore, including non-developed greenspace in studies of how the 

neighbourhood environment is related to movement behaviours will be important.   
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The association between greenspace and sedentary behaviours has also been studied. A 

study examined a wave of data from a longitudinal study of Scottish children with an average 

age of 5.9 years.60 Mothers or caregivers completed a survey asking about how far away each 

participant's home was from the nearest green or open space. The further away the nearest 

greenspace was, the more weekly TV viewing time, even after adjusting for covariates. 

Compared to living fewer than five minutes away from a green or open space, those who lived 

more than 20 minutes away engaged in over 2 more hours of TV viewing time (β = 2.49, 95% 

CI: 1.03; 3.95).60 This finding may be due to the significant perceived barrier of travelling to and 

planning the outing when it is not close by and readily available to families. Although the 

researchers did control for numerous covariates, they did not include race or SES measures, 

which could affect their social or economic resources, such as living in neighbourhoods with 

greenspace or having the means to travel by car or bus to these areas. 

2.5.4.2 Parks 

Parks are a type of greenspace that have been developed for a variety of recreational uses. 

A study found that rates of active transportation are higher in children who live in a 

neighbourhood with a variety of land uses, including parks and play areas.47 This would allow 

for children and their families to walk or cycle to the parks, further increasing their physical 

activity. On the other hand, when studying physical inactivity of Canadian youth aged 11-15, a 

study determined that compared to living in a neighbourhood with the least park space, youth 

living in neighbourhoods with moderate park space were significantly more likely (28-37%) to 

be inactive. Although, a dose-response relationship was not present, as those living in 

neighbourhoods with the most park space were only 14% more likely to be inactive and not 

significantly different than those with the least.26 
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Sedentary behaviours can also be related to parks and publicly open space. A study in 

Melbourne collected objectively measured sedentary behaviour and parent-reported screen-time 

of 5-6-year-old children and GIS-measured areas and distance to the closest public open space. 

The area of the closest park was not significantly related to the children’s total sedentary time, 

but it was significantly negatively associated with TV viewing time (β = -0.16, p ≤ 0.001).61 

Similar to playgrounds, having large, nearby outdoor areas may provide incentive to children to 

go there rather than spending time at home in front of screens.  

Few peer-reviewed studies have researched the relationship between greenspace, parks, 

and sleep outcomes. However, a graduate thesis project completed in London, Ontario, assessed 

the sleep of children aged 9-14 and the time they spent in park space using global positioning 

system (GPS) loggers. They found that those children who spent more time in and near parks had 

a longer reported sleep duration, increasing by 13 minutes for each additional percent increase in 

time spent (β = 13.40, p = 0.01).19 Further, at the 1600m buffer level, the Normalized Difference 

Vegetation Index (NDVI), which measures greenness and the vegetation level in the area, was 

positively related to the average sleep duration of the participants (β = 8.02, p = 0.05).19 A 

limitation to this study is the children’s self-reported sleep times, which could be subject to 

reporting their usual ‘bedtime’ rather than the actual time they sleep, leading to longer reported 

sleep durations. Increasing sleep when spending time outdoors within greenspace could be due to 

increased physical activity resulting in better sleep. Besides, numerous studies have found that 

exposure to greenspace is associated with beneficial mental and cognitive health outcomes, such 

as better mood and self-discipline, lower stress and anxiety, and fewer attention deficit 

hyperactivity disorder (ADHD) symptoms.62,63 This, in turn, can affect sleep, as many children 

who live with mental health issues such as ADHD or even day-to-day stressors have trouble 
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sleeping.64 Therefore, lessening symptoms and promoting calmness through exposure to nature 

may benefit sleep.  

2.5.4.3 Cul-de-Sacs 

Cul-de-sacs are short no-exit roads. At 10,000 feet above ground, a typical cul-de-sac 

would look like a lollipop. The large, circular area at the end of a cul-de-sac can act as a play 

space, and children and youth have been shown to engage in more physical activity in 

neighbourhoods with cul-de-sacs and dead ends.65 One study had parents report whether or not 

their home was located on a cul-de-sac, and those children who lived in such homes had a higher 

likelihood of playing outdoors in their yard and street on both weekdays (OR: 3.99, 95% CI: 

1.65, 9.66) and weekend days (OR: 3.49, 95% CI: 1.49, 8.16).66 Laxer and Janssen26 objectively 

measured cul-de-sac density in youths’ neighbourhoods. They found that participants living in 

neighbourhoods with the lowest density of cul-de-sacs were the most likely to be inactive (RR: 

1.27, 95% CI: 1.04, 1.52), indicating a greater presence of cul-de-sacs was associated with less 

risk of physical inactivity. These findings may be due to the safer, lower-traffic rates on these 

types of roads and their conduciveness to active outdoor play. 

Studies of cul-de-sacs and sedentary behaviour have found mixed results.61 A study of 5-

6-year-olds in Melbourne had the parents report their children’s screen time across two time 

periods (2004 and 2006). Living in a cul-de-sac in 2004 was associated with children spending 

less time using the computer or playing e-games in 2006 (β = −0.14, p < 0.05) when participants 

remained at the same address over the two years. However, it was not significantly related to 

lessening time spent watching TV or the children’s overall sedentary time.61 Alternatively, 

another study of children with a mean age of 9 years discovered the opposite association between 

sedentary behaviour and cul-de-sacs.67 They found that the higher the number of cul-de-sacs in 
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the neighbourhood, the greater the TV viewing time for the children (β = 1.3, 95% CI: 0.5, 

2.2).67 This finding may be explained by the possibility that living in a neighbourhood with many 

cul-de-sacs may make the children’s routes to different activities much longer. Therefore, 

hindering the ability to travel actively and encouraging more sedentary time. The difference 

between these two studies may stem from the fact that the Veitch et al.61 study asked whether the 

participant’s home was in a cul-de-sac. Whereas the Timperio et al.67 study measured how many 

cul-de-sacs were in each participants’ neighbourhood. A cul-de-sac’s effect on a child’s 

sedentary time would surely differ if they lived in one versus just having some in their 

neighbourhood. In addition, the age groups are still quite different among the two studies, which 

could lead to many differences in what kinds of activities they take part in and how far away 

from home they can travel. No studies have looked at the association between cul-de-sacs and 

sleep to our knowledge. 

2.5.4.4 Yard Space 

Yard space at home and in the neighbourhood could be important for children’s active 

play due to its closeness and availability. In a study in Melbourne, parents most commonly 

reported the presence of their yard at home as being the area most associated with their 

children’s active-free play outside of school hours.68 But this was more prevalent when the child 

had siblings or friends to play with. Conversely, yard space at home was negatively, but 

insignificantly, associated with preschool-aged children’s physical activity in a study from 

Kingston, Canada (β = -0.01, 95% CI: -0.01, 0.00).36 However, the children’s young age may 

have affected these results. Moreover, the study sample may lack generalizability. It only 

included those children who lived within the urban city limits and mainly recruited participants 

from licensed daycare centers, which can have financial barriers associated with enrolment. A 
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further study also assessed the reported availability of a yard to play in for Spanish children with 

the mean age of 12 years; however, they looked at its relation to screen time. They found that for 

boys, having a yard to go to was inversely related to total screen-based sedentary behaviour, (b 

(SE) = -24.24 (10.72), p < 0.05), as well as the time spent surfing the internet (b (SE) = -13.66 

(6.28), p < 0.05).53 Having the type of dwelling that supports having a yard outside for kids to 

play in or having nearby yards of friends or family members in the neighbourhood is an 

important characteristics of the neighbourhood environment related to children’s independent 

movement. To the best of our knowledge, no studies have looked at the associations of yard 

space and sleep outcomes.  

2.5.5 Noise 

Noise is a by-product of the neighbourhood’s physical environment. Although noise is 

present in every neighbourhood to a certain degree, those who reside in the largest cities and 

those with lower SES often have the most complaints of noise.69 Traffic noise is the most 

frequently cited, followed by other noises from the neighbourhood and aircraft noise. Other 

sources of excessive noise in the neighbourhood environment include industrial plants, 

construction and groundwork, emergency services, and military activities, each with varying 

types, complexities, and intensities of noise.69 All forms of transportation primarily contribute to 

environmental noise, especially during the night time in urban regions, and consequently is a 

significant cause of sleep disturbances.70,71 Although, noise disturbance is highly subjective, as 

factors such as age, sex, personality traits, and self-reported sensitivity to noise all affect how 

bothered people are by certain noises from the environment.69  

Different types of traffic noise tend to cause the most noise disturbance to sleep at night. 

For instance, a study conducted in Sweden with 79 children aged 9-12 years old reported that 
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19% of the children were either “often” or “always” bothered by road traffic noise while trying 

to sleep. Of these children, they woke up more often, had poorer sleep quality, and experienced 

more daytime sleepiness than the children who “never” or “sometimes” reported sleep 

interference from road traffic noises.71 Another study of Norwegian children at age seven had 

parents report the child’s sleep duration and sleep problems while also objectively measuring 

residential road traffic noise at night.72 They did not find statistically significant associations 

between road traffic noise and sleep duration (OR: 1.05, 95% CI: 0.94-1.17). However, after 

stratifying the sample by gender, a significant association was found among girls (OR: 1.21, 95% 

CI: 1.04-1.41) but not among boys (OR: 0.91, 95% CI: 0.78-1.06). In girls, their odds of sleeping 

10 hours or less was 21% higher, compared to sleeping 10 hours or more, for each 10-decibel 

increase in road traffic noise.72 An objective measure of sleep duration would be more accurate 

and less prone to bias or measurement error, such as parents misinterpreting time sleeping for the 

time in bed and perhaps awake. The authors noted that the observed difference between boys and 

girls may be due to girls having more noise sensitivity than boys, but they did not measure this to 

investigate further. Alternatively, boys or girls could be affected by noise during the night in 

ways beyond sleep duration and could happen without waking up, such as cardiac responses and 

unfavourable sleep stage durations.72  

Air and rail traffic noise are also common sources of sleep disturbance. However, there is 

scant research on its effects on the sleep of children specifically. An extensive study 

systematically compared the associations of air, road, and rail traffic noise with sleep in 72 

healthy adults (40 ± 13 years, range 18-71 years, 32 male).73 They recorded sleep and noise 

objectively and observed the participants in a sleep laboratory for 11 consecutive nights. It was 

found that there were significantly more arousals (M (SD) = 16.2 (6.3) vs. 14.5 (6.0), p <.01) and 
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sleep stage changes (18.2 (4.6) vs. 17.0 (5.6), p <.01) during nights of single traffic type noise 

exposure compared to no noise, respectively. Moreover, when comparing all traffic type 

exposure nights, road traffic noise demonstrated the most adverse associations with sleep 

structure and continuity, followed by rail traffic noise and aircraft noise. They also observed the 

cumulative effects of noise. Compared to nights of single traffic type noise exposure (e.g., road 

traffic), exposure nights that involved three times as many noise events made up of all three 

traffic types (air, rail, and road traffic) were associated with significant, adverse sleep outcomes. 

These outcomes included objectively measured frequency of awakenings, arousals, and sleep 

stage changes, and subjectively measured sleep quality and recuperation. Despite this difference, 

the participants’ performance in reaction time and memory tests measured each morning were 

not associated with the sleep disturbances. Although there were some statistically significant 

findings, these differences are considered marginal compared to clinical sleep disorders such as 

obstructive sleep apnea. Further, all the participants were healthy adults; therefore, the results 

could be much different among people with underlying conditions, high noise sensitivity, shift 

workers, and children.  

The associations between noise and physical activity have mostly been studied among 

adolescents and adults. For example, a study of 15-25-year-olds from Bulgaria found that road 

traffic noise level (β = -.09, p = .079) and noise annoyance (β = -.03, p = .566) were both 

negatively associated with physical activity, which in turn, affected mental health.74 Another 

study with adults had similar findings, as long-term transportation noise annoyance was 

associated with a decrease in moderate physical activity. They noted that this noise can cause 

emotional and psychological reactions as well as sleep disturbances that most likely contribute to 

the lack of physical activity.75 Therefore, neighbourhood noise may not have a direct effect on 



 

33 

 

physical activity and sedentary behaviour, but it could contribute to factors that discourage 

children’s healthy movement behaviours. We did not come across any studies assessing the 

relation between noise and sedentary behaviour in children and youth.  

2.5.6 Artificial Light 

Unnatural light exposure throughout the day and night can cause a suppression of 

melatonin levels and does not allow for proper resetting of the human circadian rhythmicity 

during the day and disrupts the rhythm at night.76,77 This can occur while working or going to 

school indoors all day with dim lighting and being exposed to bright artificial lights from the 

outside or indoors at night. This exposure contributes to heightened arousal, which can greatly 

affect the sleep/wake cycle, among other bodily functions.78,79 Much of this exposure at night 

comes from light inside the home or bedroom, whether it be from indoor lighting, television, or 

blue light emitted from screen devices. However, the neighbourhood environment can also play a 

part in this emission. Glare from street lights, the nearby glow of commercial buildings, parking 

lots, sports facilities, billboards, or even the yard light from one’s neighbour, are a few of many 

possible sources of neighbourhood lighting that could affect a person’s sleep.80 

There is very little research on the association of neighbourhood light on sleep duration, 

let alone children’s sleep duration. However, a recent study looked at the relationship between 

artificial light at night (ALAN) and sleep duration in more than 300,000 adults (aged 50-71 

years) in the US.81 After adjusting for covariates such as age, race, education, marital status, and 

lifestyle factors, both men and women were more likely to experience very short (< 5 hours) and 

short sleep (< 7 hours) with higher levels of ALAN. Among women, compared to the lowest 

exposure level of ALAN, those who experienced the highest exposure level had 20% (95% CI: 

1.03, 1.38) and 18% (95% CI: 1.11,1.25) increases in the likelihood of very short and short sleep, 
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respectively. For men, the association was even more pronounced, as those who experienced the 

highest levels of exposure to ALAN had 45% (95% CI: 1.26, 1.67) and 25% (95% CI: 1.19, 

1.31) increases in the likelihood of very short and short sleep compared to those with the lowest 

exposure levels. However, the study did not consider important factors such as room location and 

position, whether they had windows in the bedroom, or blinds or curtains on the windows if 

present. The consideration of these bedroom elements could significantly influence the results. 

Yet, the authors note that the addition of the measurement of these variables would likely result 

in non-differential misclassification, leading to an underestimation of the actual effects.81 Even 

though we must consider the limitations, this study was conducted on a very large sample and 

was able to control for numerous confounders while also being one of the few studies that 

assessed the association between outdoor ALAN and sleep duration specifically. 

 Neighbourhood light, specifically the presence of streetlights, has also been studied in 

connection to physical activity. One study with grade 6 girls throughout the US assessed the 

relationship between their objectively measured non-school MVPA and the presence of nearby 

parks and their amenities. After adjusting for covariates, the authors of this study found that 

living near parks that had streetlights was associated with an additional 18 minutes/day (p < .05) 

of non-school MVPA, and the presence of floodlights was related to an additional 22 

minutes/day (p < .05) of non-school MVPA among the girls.82 A possible reason for this finding 

is that streetlights can increase the feeling of security when engaging in outdoor nighttime 

activities.83 However, this study did not measure whether or not the MVPA took place at the 

parks, and it also only considered parks within 1 mile of the participants’ homes, which may not 

be the parks the girls frequent the most.82 Alternatively, in an overview of 13 reviews,84 of which 

primarily examined reviews assessing adults, they determined that street lighting was one feature 



 

35 

 

in the neighbourhood environment not associated with physical activity or walking. 

Comparatively, in a study of 9-10-year-old boys and girls from the UK, a higher density of 

streetlights in their neighbourhood was negatively associated with self-reported cycling to 

school. This was found in both the overall sample and when the distance to school was less than 

1 km. However, when the distance to school was greater than 1 km, having a higher density of 

streetlights was significantly positively associated with walking to school among the children.85 

This is an interesting finding that may point to the greater importance of streetlights for walking 

than for cycling. Although, unless children were actively travelling to or from school early in the 

morning or later in the evenings, streetlights would not be turned on in most cases.  

2.6 Compositional Data Analysis 

While new to epidemiology and the physical activity sciences, CoDA is a well-established 

statistical technique used for years in other fields that use data of compositional nature, such as 

geosciences, nutrition, and chemistry.86 It has recently been recommended that movement 

behaviour data use CoDA whenever possible to acquire the most accurate results.87,88,89 This 

transition must occur because researchers now recognize that each movement behaviour is a part 

of a composition and is constrained to a finite total of time, referred to as the 24-hour movement 

behaviour composition.90 These daily movement behaviours must also be considered co-

dependent variables, as time spent in each of the movement behaviours within a 24-hour period 

affects the time spent in the other movement behaviours. For example, if a child spends 8 hours 

per day being sedentary, that means the time they can spend in physical activity and sleep is 

limited to 16 hours.88  

In past physical environment and movement behaviour research, studies did not address the 

compositional nature of movement behaviour data. Sleep, sedentary behaviour, and all intensities 
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of physical activity were traditionally assessed in isolation.87 This method of assessing each 

behaviour in isolation typically used statistical techniques such as multiple linear regressions. 

That type of analysis requires the behaviour variables to be treated as independent, absolute 

values that are unconstrained and infinite, known to occur in real (or Euclidean) space.86,91 

However, we now recognize the finite and co-dependent nature of movement behaviour data, so 

using traditional statistical analyses can lead to spurious findings.91  

One of the major differences between absolute data, such as an isolated physical activity 

measure, and compositional data, such as the 24-hour movement behaviour composition, is that 

compositional data do not occur in real space. Compositional data occurs in a subset of real 

space called the simplex, which has the constant sum constraint (e.g., 24 hours) rather than 

occurring in standard Euclidean space (from - ∞ to + ∞). Compositional data consists of its own 

natural geometry, coined the Aitchison geometry.92 In order to deal with the geometry of 

compositional data, CoDA involves converting the data. The conversion is usually accomplished 

through isometric log-ratio (ilr) transformation, making the ratios between the movement 

behaviours the primary interest and allows the data to be used in real space, the same as 

traditional multivariate statistical analyses.86,93 The ilr transformation addresses the issue of the 

co-dependent variables that normally would introduce detrimental multi-collinearity into a 

regression model.91 

The steps involved in CoDA are first to transform the movement behaviours variables into 

ilr coordinates in real space. Then, to use these coordinates as either the predictor or outcome 

variables in standard statistical analyses such as linear regression. Finally, to interpret and back-

transform the results using a compositional paradigm. This means considering the relative 
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distributions of time between each behaviour and not just the absolute values of each 

independent behaviour from the regressions.  

2.7 Summary and Conclusions 

The literature examining associations between the neighbourhood physical environment and 

movement behaviours is vast. Table 2.1 provides a high-level summary of what has been 

observed in the previous studies cited. The table demonstrates the many neighbourhood physical 

environment features hypothesized to be associated with the movement behaviours of children 

and youth, with mixed findings among the literature. For example, both dedicated and non-

dedicated play and activity spaces have shown considerable favourable associations with each of 

the different movement behaviours. They include mostly positive associations with physical 

activity and sleep and primarily negative relationships with sedentary behaviour, thus providing 

more optimal physical and mental health outcomes. However, the other features are more 

variable in their associations. Many of these associations are inconsistent in different studies, and 

they vary depending on the movement behaviour examined. This may stem from differences in 

measurement type (e.g., objective vs. perceived), domain of movement behaviour (e.g., active 

transportation vs. total MVPA; screen time vs. total SED), and various study populations and 

locations. Further, it highlights that only a few exposures have been studied in relation to all 

three movement behaviours in children and youth.   
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Table 2.1 Summary of overall associations between neighbourhood physical environment 

features and children and youth’s individual movement behaviours from narrative literature 

review 

Exposure Physical Activity Sedentary Behaviour Sleep 

Walkability ↔ ↔ ? 

-Street connectivity ↔ ? ? 

-Proximity to 

destinations 

↑ ? ? 

-Pedestrian safety and 

infrastructure 

↑ ↔ ↔ 

Traffic Safety ↔ ↔ ? 

-Traffic 

speed/volume 

↔ ↔ ? 

-Traffic calming  ? ? ? 

-Pedestrian safety 

infrastructure 

↑ ↔  ↔ 

Dedicated play and 

activity spaces 

↔ ↓ ↑ 

-Sport facilities ↑ ? ? 

-Recreation facilities ↔ ↔ ↑ 

Non-dedicated play 

and activity spaces 

↑ ↔ ↑ 

-Greenspace  ↑ ↓ ↑ 

-Parks ↔ ↔ ↑ 

-Cul-de-sacs ↑ ↔ ? 

-Yard space ↔ ↔ ? 
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Noise ↓ ? ↓ 

-Emergency services ↓ ? ↔ 

-Traffic volume ↓ ? ↔ 

-High-speed traffic ↓ ? ↔ 

-Railroad traffic ↓ ? ? 

-Airport traffic ↓ ? ? 

Artificial light at 

night 

↔ ? ↓ 

-Streetlights ↔ ? ? 

-Commercial 

building light 

? ? ? 

↑: green upward arrow indicates consistent evidence of a positive association; ↓: red downward 

arrow indicates consistent evidence of a negative association; ↔: sideways arrows indicate an 

inconsistent evidence (e.g., mixture of positive and negative associations) or primarily null 

associations; ?: question mark indicates unknown associations as there is no known evidence 

including the associations among children and youth. 
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It is important to note that most physical activity studies reviewed and included in the table 

focused on total physical activity, MVPA, or a specific type of physical activity, such as active 

transportation. Therefore, they did not differentiate between MVPA and light-intensity physical 

activity (LIPA). However, LIPA makes up far more time in the 24-hour day than MVPA. It has 

also shown beneficial effects on cardiometabolic health and obesity, making it an essential 

component of the 24-hour movement behaviour guidelines.94–96 Moving forward in the thesis, we 

will include LIPA as one of the four movement behaviours.  

Other key limitations in the past literature are that the physical environment's effects are 

typically assessed relative to only one of the movement behaviours independently. Because only 

one or two behaviours are considered at a time in these studies, the compositional nature of 

movement behaviour data is not recognized. This leads to inconsistent and misleading findings, 

such as biased and increased effect sizes, resulting from traditional statistical analyses that do not 

address the co-dependence and finite nature of the movement behaviours like CoDA does.97,88 

Further, most studies only include a couple aspects of the neighbourhood physical environment 

when assessing their relationship with movement behaviours. Considering many features at once 

creates a more holistic view of the neighbourhood physical environment. Moreover, as displayed 

in Table 2.1, many relevant features of the neighbourhood physical environment have not yet 

been studied in relation to children and youth's movement behaviours, so including all of these 

variables will address some significant literature gaps.  

A study that addresses all the movement behaviours and a wide range of objectively 

measured environmental variables simultaneously is needed. Moreover, CoDA has been 

recognized as the preferred statistical analysis technique when addressing time-use data such as 

the 24-hour movement behaviour composition. Therefore, employing this technique can help us 
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develop a clearer picture of how the neighbourhood physical environment is related to children’s 

movement behaviours.  
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Chapter 3 

The Neighbourhood Physical Environment and the 24-Hour Movement 

Behaviour Composition Among Children 
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3.1 Abstract 

INTRODUCTION: Researchers have recognized the health relevance of the 24-hour movement 

behaviour composition and the potential for the neighbourhood to promote healthy movement behaviours. 

However, research has not yet considered which neighbourhood environment features are associated with 

all components of the 24-hour movement behaviour composition. The objective of this study was to use 

compositional data analysis (CoDA) to identify differences in the 24-hour movement behaviour 

composition among children based on neighbourhood physical environment features. 

METHODS: 458 children aged 10-13 years from Kingston, ON were studied. Neighbourhood physical 

environment variables were measured in 1 km buffers from the participants’ homes using geographic 

information system (GIS) databases. Twenty-three neighbourhood environment characteristics were 

measured, and from these, six indices were created, including walkability, traffic safety, dedicated play 

and activity spaces, non-dedicated play and activity spaces, noise, and artificial light. Moderate-to-

vigorous physical activity, light physical activity, sedentary time, and sleep duration were measured on 

seven days using accelerometers and sleep logs. CoDA was used to establish differences in the movement 

behaviours among groups defined by the neighbourhood physical environment features. 

RESULTS: A total of 29 associations between neighbourhood environment features and movement 

behaviours were examined and only three exposures had statistically significant differences in movement 

behaviour compositions. For these three, the significant difference occurred for only one of the four 

movement behaviours and for only one of three pairwise comparisons for the exposure levels. All of these 

significant associations were for non-dedicated play and activity spaces. These significant results included 

subtle differences, did not follow dose-response patterns, and were not always in the expected direction.  

CONCLUSIONS: Neighbourhood physical environment features were not meaningful correlates of 24-

hour movement behaviours.  
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3.2 Introduction 

Research on the health benefits of movement in children has historically focused on the 

benefits of moderate-to-vigorous physical activity (MVPA).1 However, time children spend in 

MVPA accounts for <5% of the 24-hour day.2 In the past decade, researchers have recognized 

the health relevance of the movement intensities that make up the remaining 95% of the day, 

including light-intensity physical activity (LIPA) (e.g., standing, walking slowly), sedentary 

behaviour (SED) (e.g., sitting), and sleep.3,4 Furthermore, recent research has demonstrated that 

the entire 24-hour movement behaviour composition, defined as the relative proportions of the 

24-hour day devoted to different intensities of physical activity, sedentary behaviour, and sleep, 

is important for health.5,6 

Movement behaviours can be associated with the neighbourhood physical environment. A 

child’s physical activity can be related to the street network design and the number of parks in 

their neighbourhood,7,8 their SED can be associated with the availability and accessibility of 

sport and recreation facilities9 and the presence of cul-de-sacs,10 and their sleep can be affected 

by noise and artificial light coming from the neighbourhood environment.11,12 However, there is 

no consensus among the literature, as many studies have found null or opposite results to what 

may have been expected.e.g.,7,13–15 Although studies have examined the associations between the 

neighbourhood environment and physical activity,7,16 SED,10,17 and sleep18,19 on their own, 

research has not yet considered which neighbourhood environment features are associated with 

all components of the 24-hour movement behaviour composition. Planning strategies and public 

health guidelines could be informed by research that identifies modifiable features of the 

neighbourhood environment that affect all components of the movement behaviour composition. 
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Statistical analyses that assess the relationship between the neighbourhood physical 

environment and components of the 24-hour movement behaviour composition should account 

for the compositional nature of movement behaviours. Traditional statistical analyses analyze 

movement behaviours independently. This is an issue because movement behaviours are co-

dependent. Movement behaviours are co-dependent because their summed time adds up to 24-

hours per day. Thus, if time in one movement behaviour changes (e.g. decreasing one hour of 

SED) an equal and opposite change must occur in some combination of the other movement 

behaviours (e.g. increase physical activity and sleep by one hour).20 Further, traditional analyses 

usually treat movement behaviours as occurring in standard Euclidean space (from - ∞ to + ∞). 

However, movement behaviours are time use data, such that they are constrained components of 

the finite 24-hour day. For these reasons, the use of traditional statistical analyses approaches can 

lead to spurious findings.21 Compositional data analysis (CoDA) statistical techniques are 

appropriate for analyzing data that is a composition of a finite whole, like movement behaviours 

in a 24-hour day.20  

The objective of this study was to use CoDA to identify neighbourhood physical 

environment features that are associated with multiple components of the 24-hour movement 

behaviour composition among children. 

3.3 Study Design and Methods  

3.3.1 Data Source and Study Participants 

This study used data from the Active Play Study, a cross-sectional study of 458 children 

aged 10-13 years from Kingston, ON. Data were collected from January 2015 to December 

2016. The inclusion criteria consisted of residing in and attending school in Kingston and being 

able to communicate in English or French. Non-ambulatory children were excluded due to the 
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need to wear a waist-worn accelerometer to assess their daily movements. Participant 

recruitment occurred through various advertisements (social media, newspaper), brochures and 

flyers distributed to schools, camps, and other organizations, and word of mouth. Recruitment 

was done to ensure proportional representation across the season of data collection and by the 

participants’ age, sex, and residence in Kingston’s 12 electoral districts. 

Informed consent from parents and assent from children were obtained. Ethics approval for 

the study and the secondary analyses presented here was obtained from the Queen’s University 

General Research Ethics Board (see Appendix B).   

3.3.2 Exposure Variables 

The exposure variables of interest consisted of neighbourhood physical environment features 

that are known to be related to physical activity, sedentary behaviour, and/or sleep as determined 

in a literature review (Chapter 2). They included measures of walkability, traffic safety, 

dedicated play and activity spaces, non-dedicated play and activity spaces, noise, and artificial 

light.  

The neighbourhood for each participant was determined by creating a 1 km road-network 

buffer around their home for the features that would be accessed by travel on roads at the ground 

level (i.e., walkability, traffic safety, and play and activity spaces) and a 1 km circular buffer 

around their home for features that would travel through air (i.e., noise and artificial light). A 

road-network buffer was chosen over a circular buffer for most exposures as it more accurately 

represents the active transportation habits in children. The 1 km distance was chosen because it 

represents a ~10-15-minute walk or ~5 min bicycle ride, and is a common independent mobility 

range for this age group.22,23 Also, when researching the association between food retail 
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environments and eating behaviours, a 1-km road network buffer best demonstrated the 

independent mobility of 10-12 year olds.22 

Neighbourhood physical environment variables were measured objectively using geographic 

information system (GIS) databases from the City of Kingston, DMTI Spatial (DMTI Spatial 

ULC, Richmond Hill, Ontario, Canada), and Crime Reports (Motorola Solutions Inc, Chicago, 

Illinois, USA) in ArcGIS software (ESRI, Redlands, California, USA); satellite and street view 

images in Google Earth Pro (Google, Mountain View, California, USA); the Walk Score® 

internet platform (Walk Score®, Seattle, Washington, USA); and the 2011 Canadian Census of 

Population using PCensus for MapPoint (Tetrad, Ferndale, Washington, USA). Some of the 

neighbourhood physical environment features reflected counts (e.g., number of streetlights in 

buffer per km2 of land area) (see Appendix C for example of GIS count protocol), some reflected 

distances (e.g., length of high-speed roads contained within buffer) (see Appendix D for example 

of GIS distance protocol), some reflected areas (e.g., % of land area made up of non-park green 

space) (see Appendix E for example of GIS area protocol), and some reflected combinations of 

multiple measures (e.g., connectivity scores were based on the number of intersections and dead-

ends and the lengths of roads in the neighbourhood buffer). In some instances, a proxy measure 

was used when a direct measure of the variable of interest was not available. For instance, 

neighbourhood artificial light exposure was based on the number of streetlights and the presence 

of a commercial building(s) in the neighbourhood buffer since a direct measure (i.e., intensity of 

light at night) was not available.  

Table 3.1 summarizes the GIS variables that were measured, briefly describes them (refer to 

the provided references for detailed information), indicates how the exposure groups were 

classified, and lists the source of the data. Variables are organized according to the following 
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categories: walkability, traffic safety, dedicated play and activity spaces, non-dedicated play and 

activity spaces, noise, and artificial light. In addition to examining the individual GIS measures, 

indices of these measures were created for each exposure variable of interest. To create these 

indices, percentile ranks of each of the individual measures, except for the individual noise 

measures, were created. These individual ranks were averaged and tertiles were created based on 

these averages. For the 8 noise measures, scores of 0 (no) or 1 (yes) were assigned. The 8 scores 

were summed and participants were placed into tertiles based on this sum. Tertiles were chosen 

to ensure a reasonable sample size in each category and to limit the number of pair-wise 

comparisons that needed to be made among exposure groups. A sensitivity analysis based on 

quintiles revealed similar patterns of findings as the patterns that were revealed by tertiles. 
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Table 3.1 Overview of GIS neighbourhood physical environment measures 

Name of measure Explanation of measure 

and reference for 

measurement protocol 

Exposure 

groups  

GIS data source(s) 

Walkability 

Street Connectivity 

Length of roads  Distance of all road 

segments24 

Tertiles GIS Kingston Road_Segment 

Intersection density No. intersections per km2 

land area24 

Tertiles GIS Kingston Road_Intersection and 

Land_Use 

Average block length Length of roads/No. 

intersections24 

Tertiles GIS Kingston Road_Segment and 

Road_Intersection 

Connected node ratio Intersections/all nodes 

including cul-de-sacs24 

Tertiles 

 

GIS Kingston Road_Intersection and 

Road_Segment 

Proximity to destinations 

Walk Score® Online tool that estimates 

the access to walkable 

amenities in the 

neighbourhood weighted 

according to their proximity 

and importance24 

Tertiles 

 

https://www.walkscore.com 

Distance to school Road network distance to 

the participants’ school24 

Tertiles 

 

GIS Kingston Road_Segment and 

Land_Use 

Population density No. people per km2 of land 

area24 

Tertiles 2011 Canada Census of Population and 

City of Kingston Land_Use 

Pedestrian safety and infrastructure 

Traffic volume Proxy measure estimated by 

multiplying the length of 

arterial, collector and local 

roads by the average traffic 

volume of these road types 

in Kingston, adding them 

together, and dividing by 

the total length of roads24 

Tertiles GIS Kingston Road_Segment 

 

Length of sidewalks Distance of all sidewalk 

segments24 

Tertiles GIS Kingston Sidewalk_Segment 

Traffic calming  Number of speed humps, ≤ 

40 km/h low speed zones 

including school zones, 

crosswalks, 4-way-stop 

signs, playground/children 

Tertiles GIS Kingston Speed_Humps, 

Traffic_Sign, and Road_Segment 

https://www.walkscore.com/CA-ON/Kingston
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playing signs, and 

pedestrian walking signs24 

Traffic safety    

Traffic speed A proxy measure that 

reflects that vehicle speeds 

are typically lower on local 

roads than on collector and 

arterial roads. The traffic 

speed was calculated as: 

((distance of local roads in 

buffer) / (total road distance 

in buffer) ∗ (−1))7. 

Tertiles GIS Kingston Road_Segment 

Traffic volume Proxy measure estimated by 

multiplying the length of 

arterial, collector and local 

roads by the average traffic 

volume of these road types 

in Kingston, adding them 

together, and dividing by 

the total length of roads24 

Tertiles 

 

GIS Kingston Road_Segment 

Pedestrian 

infrastructure 
Length of sidewalks24 Tertiles GIS Kingston Sidewalk_Segment 

Traffic calming Number of speed humps, ≤ 

40 km/h low speed zones 

including school zones, 

crosswalks, 4-way-stop 

signs, playground/children 

playing signs, and 

pedestrian walking signs24 

Tertiles GIS KingstonSpeed_Humps, 

Traffice_Sign, and Road_Segment 

Dedicated play and activity spaces 

Sport facilities Number of sport facilities 

(arenas, schools, sport 

fields, courts, and tracks) 

per km2 of land area 

(arenas, schools, sport 

fields, courts, and tracks)23 

Tertiles GIS Kingston Sport  

 

 

Recreation facilities Number of recreation 

facilities (driving ranges, 

batting cages, outdoor 

rinks, play structures, 

skateboard parks, 

swimming pools, swing 

sets, general recreation 

facilities) per km2 of land 

area23 

Tertiles GIS Kingston Recreation 
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Non-dedicated play and activity spaces  

Parks Proportion of total land area 

devoted to park space23 
Tertiles GIS Kingston Park and Land_Use  

Non-park greenspace  Undeveloped greenspace 

area (calculated as total 

green space minus park 

space)15 

Tertiles GIS Kingston Park and Land_Use and 

DMTI vegetation 

Cul-de-sacs Number of cul-de-sacs per 

km2 land area2,15 
Tertiles GIS Kingston Road_Segment 

Yard space Average residential 

property size (calculated as 

residential parcel size - 

residential building 

footprint areas) in 

neighbourhood buffer25 

Tertiles GIS Kingston Parcel_LandUse, 

Building, and Residential_Land 

Noise    

Emergency services Presence of hospital in 

neighbourhood buffer 

Presence of a fire station in 

neighbourhood buffer  

Presence of ambulance 

station in neighbourhood 

buffer  

Presence of police station in 

neighbourhood buffer26 

Yes/No 

 

Yes/No 

 

Yes/No 

 

 

Yes/No 

GIS Kingston Hospital  

 

GIS Kingston Fire_station 

 

GIS Kingston Building 

 

 

GIS Kingston Police_Station 

Traffic volume Previously explained under 

pedestrian safety and 

infrastructure 24,26 

Top and 

bottom 50% 

 

GIS Kingston Road_Segment  

High-speed traffic  Presence of expressway in 

neighbourhood buffer26 
Yes/No GIS Kingston Road_Segment 

Railroad traffic Presence of a railroad in 

neighbourhood buffer26 
Yes/No GIS Kingston Rail 

Airport traffic Presence of airport in 

neighbourhood buffer26 
Yes/No GIS Kingston AirportPoly 

Artificial light at night 

Streetlights Number of streetlights 

(including street lights, 

security lights, park lights, 

and parking lot lights) per 

km2 land area27 

Tertiles GIS Kingston Streetlights_UK 
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Commercial building 

light 
Presence of a commercial 

building(s) in 

neighbourhood buffer27 

Tertiles GIS Kingston Building 
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3.3.3 Outcome Variables 

The outcome variables were the relative proportions of the 24-hour day comprised of 

MVPA, LIPA, SED and sleep. To measure these, participants wore an Actical accelerometer 

(Philips Respironics, Murrysville, Pennsylvania, USA) and filled out a sleep log over 7 

consecutive days and nights. The accelerometer was worn continuously on the right hip unless 

bathing or participating in a water activity (see Appendix F for accelerometer instructions for 

participants). The accelerometer recorded movement in 15 second epochs. Any time the 

accelerometer was removed it was recorded on the log (see Appendix G). Time to bed each night 

and time waking up each morning was recorded on the sleep log.  

Sleep duration was determined based on the times recorded on the sleep logs (see Appendix 

H). In some instances, the recorded sleep times were corrected to adjust for likely recording 

errors. Specifically, all times recorded on the sleep log were visually inspected against the 

accelerometer data. When necessary, the times were corrected by a member of the research team.  

Ninety percent of the verified and corrected sleep times were within 10 min of each other when 

repeatedly completed by different researchers.28  

To determine time spent in the other movement behaviours during waking hours, sleep time 

and time identified in the logs as non-wear time were removed from the accelerometer data. 

Further, times that were not stated as non-wear time in the log were identified with an algorithm. 

The algorithm looked for consecutive 0 counts over 60-minute segments.29 The remaining time 

reflected times that the participant was awake and wearing the accelerometer. This time was 

categorized as MVPA (>1499 counts/min), LIPA (100–1499 counts/min), or SED (<100 

counts/min).30 Days with <10 hours of accelerometer wear time during waking hours were 

excluded and participants with <4 valid days of accelerometer data were excluded.30 In this 
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dataset, 95% of participants had at least 4 valid days of accelerometer data, while 92% had 6 or 7 

valid days.  

The initial movement behaviour values were each assessed for their arithmetic mean and 

median. However, the movement behaviour values for the rest of the analysis were adjusted and 

closed to the total time of 1440 minutes/day, or 24 hours/day, to become the compositional 

means for the movement behaviours. This was done by dividing the average time per day in each 

behaviour by the average minutes of total recorded behaviour time. This proportion of time was 

then multiplied by 1440 minutes to reflect the adjusted behaviour time based on 24 hours. This 

ensured uniform time for each participant and is a better representation of central tendency in 

compositional data.20,31 

3.3.4 Covariates 

Numerous covariates were considered based on their known relationship with one or more 

movement behaviour and their potential relationship with the exposure variables. Child-level 

covariates included sociodemographic factors such as their sex, age, difference from age of peak 

height velocity as a measure of biological maturation,32 body mass index (BMI) category based 

on the World Health Organization references,33 race (white or non-white including mixed race), 

family structure (single or dual parent household, number of siblings in the home), parent 

education (high school or less, 2-year college, or 4-year college/university), and annual 

household income (≤ $50,000, $50,001–$100,000, or > $100,000). Other factors that were 

considered included per capita rates of neighbourhood property crime and neighbourhood crime 

against persons,34 the season of data collection (December-March, April-June, July-August, 

September-November), and average daily temperature, daily precipitation, and daylight hours 

during each participants’ week of data collection.35,36  
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3.3.5 Statistical Analysis 

All statistical analyses used SPSS v 26.0 (IBM Corp, Armonk, USA). A p-value of <0.05 

was used to denote statistical significance. Standard descriptive statistics were computed for the 

variables of interest such as arithmetic and compositional means, medians, and prevalences. The 

co-dependence of the movement behaviours was examined through a pair-wise log-ratio 

variation matrix. Values closer to zero indicated that the two behaviours in the ratio were highly 

proportional and co-dependent.20  

CoDA was then used to establish differences in 24-hour movement behaviour compositions 

among different groups defined by the neighbourhood physical environment variables. This 

process was based on the procedure outlined by Martìn-Fernandez and colleagues.37 The initial 

step was to transform the movement behaviour variables from their natural and constrained space 

onto unconstrained real space using isometric log ratio (ilr) transformations. This transformation 

expressed the movement behaviour composition into ratios of the individual movement 

behaviours (sleep, SED, LIPA, MVPA). Because there are four daily movement behaviours 

(sleep, SED, LIPA, and MVPA), each compositional part was expressed as three ilr coordinates. 

For example, the three ilr coordinates for sleep were transformed and calculated as follows21: 

               Z1 = √
3

4 
𝐼𝑛 (

𝑠𝑙𝑒𝑒𝑝

√𝑆𝐸𝐷×𝐿𝐼𝑃𝐴×𝑀𝑉𝑃𝐴
3 ), Z2 =√

2

3 
𝐼𝑛 (

𝑆𝐸𝐷

√𝐿𝐼𝑃𝐴×𝑀𝑉𝑃𝐴
), and Z3 = √

1

2 
𝐼𝑛 (

𝐿𝐼𝑃𝐴

𝑀𝑉𝑃𝐴
) 

This process was repeated so that each movement behaviour was positioned as the 

numerator in the equation of the first coordinate against the remaining behaviours as the 

denominator. When transforming the values into ratios, zero values of the components, such as 

no time spent in MVPA, cannot be used, meaning CoDA cannot be employed. Often, if zeroes 

are present, merging multiple behaviours or imputation techniques are used.31,38 In this study 

sample, there were no zero values present; therefore, avoiding the zero issue. Once all the 
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movement behaviour data were transformed, the three ilr coordinates of each movement 

behaviour were entered as the outcome variables in separate multivariate analysis of variance 

(MANOVA) models for the neighbourhood physical environment exposure variables. The 

Wilks’ Lambda and p-values associated with the first coordinate in each model were the only 

values that were meaningfully interpreted, as the first coordinate is the one that provides the 

relevant information of the numerator variable relative to the remaining movement behaviours.21 

The other two coordinate variables are simply used to fit the model, but they do not add 

meaningful information.  

If the MANOVA suggested rejecting the null hypothesis, Hotelling’s T-squared test, the 

multivariate generalization of a standard t-test, was used to determine which pair of groups were 

different.37 If differences between two groups were found, D− 1 simultaneous t-tests were used 

to determine which ilr coordinates were responsible for the differences.37  

To determine which confounding variables to include in the MANOVA models, the 

relationship between each confounding variable and each movement behaviour was determined 

in a series of bivariate analyses. Confounding variables associated with any movement 

behaviours based on a conservative p value of < 0.2 were controlled for in all MANOVA 

models. This ensured that each model was adjusted for the same confounding variables.  

To explore whether there were sex or age interactions, a series of sex and age stratified 

analyses were run. The patterns of association in the stratified analyses were generally the same 

as in the full sample. Therefore, analyses were run on all participants together and sex and age 

were controlled for as confounding variables.  
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3.4 Results  

3.4.1 Descriptive Characteristics  

Twenty four of 458 participants were excluded because of insufficient accelerometer data. 

Descriptive sociodemographic and familial characteristics of the 434 participants included in the 

final analyses are summarized in Table 3.2. Participants were approximately evenly distributed 

across sex and age. The majority were white (86%), had a non-overweight BMI (73%), and lived 

in dual-parent households (86%). Compared to participants included in the analysis, those who 

were excluded due to insufficient accelerometer data were significantly more likely to be 13 

years old (p = .021). Other sociodemographic characteristics were not significantly different 

between the included and excluded participants. 

The compositional means for sleep, SED, LIPA, and MVPA were (in hours:minutes per 

day) 9:34, 10:27, 3:00, and 1:00, respectively (Table 3.3). The greatest pair-wise log ratio 

variances were between MVPA and SED (0.21), followed by MVPA and sleep (0.20), and 

MVPA and LIPA (0.15). The lowest variances were between sleep and SED (0.02), sleep and 

LIPA (0.06), and SED and LIPA (0.07). Therefore, MVPA had the least co-dependency with the 

other movement behaviours. 

The descriptive statistics of the neighbourhood GIS characteristics are summarized in Table 

3.4. Participants had a median neighbourhood Walk Score® of 40 out of a 100. The median 

number of sport and recreation facilities in the participants’ neighbourhoods were 3 and 5, 

respectfully. Participants had a median of 209 streetlights and 3 commercial buildings in their 

neighbourhood.  Less than one in three lived within 1 km of each of the noise exposures.  
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Table 3.2 Participant characteristics 

Characteristic N % 

Sex   

     Male 216 49.8 

     Female 218 50.2 

Age (years)   

     10 110 25.3 

     11 112 25.8 

     12 114 26.3 

     13 98 22.6 

Body mass index category   

     Non-overweight 317 73.0 

     Overweight 75 17.3 

     Obese 42 9.7 

Race   

     White 373 85.9 

     Non-white 61 14.1 

Family income ($ CDN per 

year) 

  

     ≤50,000 66 15.2 

     50,001 to 100,000 117 27.0 

     >100,000 200 46.1 

     Not reported 51 11.8 

Parental education   

     High school or less 38 8.8 

     2-year college 131 30.2 

     4-year college/university 265 61.1 

Number of parents in household   

     Single parent 59 13.6 

     Dual parent 372 85.7 

     Not reported 3 .7 
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Table 3.3 Descriptive characteristics of movement behaviours 

Movement behaviour 

component 

Raw 

composition 

arithmetic 

mean (SD) 

Median (IQR) 24-hour standardized 

composition compositional 

mean (SD) 

Sleep 9:28 (0:47) 9:28 (8:59, 9:59) 9:34 (0:49) 

SED 10:22 (1:21) 10:10 (9:31, 10:58) 10:27 (1:2) 

LIPA 2:58 (0:39) 2:58 (2:32, 3:21) 3:00 (0:36) 

MVPA 0:59 (0:26) 0:55 (0:41, 1:13) 1:00 (0:26) 

Total  23:48 (1:29) 23:35 (23:6, 23:55) 24:00 

Data presented as hours:minutes. 
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Table 3.4 Description of neighbourhood GIS measures  

Environmental Measure Median (IQR) or Prevalence 

Street Connectivity  

     Length of roads, km 10.32 (6.97-13.75) 

     Intersection density, No. per km2 land area 11.24 (7.04-15.61) 

     Average block length, km 0.30 (0.26-0.35) 

     Connected node ratio, ratio of intersections to all 

nodes including cul-de- sacs 

0.78 (0.67-0.86) 

Proximity to destinations  

     Walk ScoreⓇ, range 0-100 40 (25-54) 

     Distance to school, km 1.60 (0.80-4.20) 

     Population density, No. per km2 land area 1652 (1077-2227) 

Traffic volume and traffic speed  

     Arterial road distance, km 1.52 (0.84-2.55) 

     Collector road distance, km  0.13 (0.00-1.49) 

     Local road distance, km 7.76 (5.21-11.25) 

Traffic calming  

     School zone signs, No. 2 (0-4) 

     Crosswalk signs, No. 0 (0-0) 

     Speed humps, No. 3 (0-7) 

     40 km/h speed zone signs, No. 0 (0-4) 

     Playground/children playing signs, No. 2 (0-4) 

     Pedestrian walking signs, No. 0 (0-1) 

Pedestrian infrastructure  

     Sidewalk distance, km 9.88 (6.50-13.84) 

Play and activity spaces  

     Sport facilities, No. 3 (1-8) 

     Recreation facilities, No. 5 (2-8) 

     Parks, km2 0.16 (0.10-0.26) 

     Non-park greenspace, km2 0.19 (0.04-0.53) 

     Cul-de-sacs, No. 7 (4-11) 

     Yard space, m2 668 (488-1061) 

Light  

     Streetlights, No. 209 (124-269) 

     Commercial buildings, No. 3 (0-14) 

Noise  

     Hospitals, % neighbourhoods 13.1 

     Fire stations, % neighbourhoods 31.6 

     Ambulance stations, % neighbourhoods 10.1 

     Police stations, % neighbourhoods 4.8 

     High-speed traffic, % neighbourhoods 4.6 

     Railroad, % neighbourhoods 32.0 

     Airport, % neighbourhoods 8.5 

The data are presented as median (interquartile range) for continuous variables and as a prevalence for the 

categorical noise variables.  
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3.4.2 Compositional MANOVA 

Mean differences in 24-hour movement behaviour compositions between tertiles of the six 

neighbourhood physical environment exposure indices and their individual components are 

presented in Tables 3.5-3.10. Each table provides the back-transformed group mean ilr 

coordinates presented as hours:minutes per day. Means were adjusted for the age, sex, race, BMI 

category, difference from age at peak height velocity, season of participation, household income, 

parental education, number of parents in household, and neighbourhood property crime rate. A 

summary table of the associations between neighbourhood physical environment indices and 

their individual features are presented in Table 3.11.  

There were no significant differences in sleep, SED, LIPA, or MVPA across tertiles of the 

walkability index or the measures that comprised this index (Table 3.5). Similarly, there were no 

significant group differences in any of the movement behaviours across groups defined by the 

neighbourhood traffic safety (see Table 3.6), dedicated play spaces (Table 3.7), noise (Table 

3.9), and artificial light (Table 3.10) indices and individual measures. The only significant 

differences that were observed in the 24-hour movement behaviour composition variables were 

for a few of the non-dedicated play space variables (Table 3.8). Specifically, children in the 

middle non-dedicated play spaces index tertile accumulated an additional 8 minutes/day of LIPA 

than children in the low tertile (p = .011). Furthermore, children in the high yard space tertile had 

6 fewer minutes of MVPA compared to children in the low tertile (p = .011). Finally, children in 

the middle cul-de-sac tertile accumulated 29 minutes more SED than children in the low tertile 

(p = .003).  
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Table 3.5 Model-adjusted compositional mean by neighbourhood walkability factors 

Walkability component Sleep  SED  LIPA  MVPA  

Walkability index     

     Low 10:43 (9:46, 11:47) 12:19 (11:06, 13:39) 2:56 (2:42, 3:12) 0:45 (0:38, 0:54) 

     Moderate 10:43 (9:43, 11:50) 12:23 (11:06, 13:50) 2:55 (2:40, 3:12) 0:44 (0:37, 0:53) 

     High 10:48 (9:47, 11:55) 12:31 (11:13, 13:57) 2:53 (2:38, 3:09) 0:48 (0:40, 0:57) 

Connectivity     

     Low 10:25 (9:24, 11:32) 12:21 (11:3, 13:49) 2:52 (2:37, 3:09) 0:47 (0:39, 0:56) 

     Moderate 10:33 (9:31, 11:41) 12:00 (10:43, 13:25) 3:00 (2:44, 3:17) 0:47 (0:39, 0:57) 

     High 10:59 (9:56, 12:10) 12:15 (10:57, 13:42) 2:58 (2:42, 3:15) 0:46 (0:38, 0:56) 

Proximity to destinations     

     Low 10:47 (9:41, 11:58) 12:09 (10:49, 13:39) 3:02 (2:46, 3:21) 0:47 (0:39, 0:57) 

     Moderate 10:34 (9:36, 11:36) 12:07 (10:55, 13:27) 2:53 (2:38, 3:08) 0:45 (0:38, 0:53) 

     High 10:36 (9:34, 11:44) 12:20 (11:01, 13:47) 2:55 (2:39, 3:12) 0:48 (0:40, 0:58) 

Pedestrian safety and infrastructure 

     Low 10:39 (9:39, 11:45) 11:55 (10:41, 13:17) 2:55 (2:40, 3:11) 0:46 (0:38, 0:55) 

     Moderate 10:31 (9:31, 11:39) 12:14 (10:56, 13:40) 2:57 (2:41, 3:14) 0:47 (0:39, 0:56) 

     High 10:46 (9:42, 11:56) 12:27 (11:06, 13:59) 2:58 (2:42, 3:15) 0:47 (0:39, 0:57) 

Note: Data presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, household 

income, education, single/dual parenting, difference from age of peak height velocity, and property crime. 
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Table 3.6 Model-adjusted compositional mean by neighbourhood traffic safety factors. 

Traffic safety component Sleep  SED  LIPA  MVPA  

Traffic safety index     

     Low 10:39 (9:42, 11:43) 12:16 (11:04, 13:37) 2:55 (2:40, 3:10) 0:46 (0:38, 0:54) 

     Moderate 10:47 (9:47, 11:54) 12:22 (11:05, 13:47) 2:56 (2:40, 3:12) 0:46 (0:38, 0:55) 

     High 10:48 (9:47, 11:56) 12:39 (11:20, 14:08) 2:53 (2:38, 3:10) 0:46 (0:38, 0:55) 

Traffic volume     

     Low 10:38 (9:39, 11:45) 12:16 (11:00, 13:40) 2:52 (2:37, 3:08) 0:48 (0:40, 0:58) 

     Moderate 10:40 (9:38, 11:50) 12:18 (10:59, 13:46) 2:56 (2:40, 3:13) 0:45 (0:38, 0:55) 

     High 10:50 (9:42, 12:04) 12:42 (11:16, 14:19) 3:03 (2:46, 3:22) 0:43 (0:35, 0:52) 

Traffic speed     

     Low 10:41 (9:35, 11:53) 12:28 (11:04, 14:03) 3:00 (2:43, 3:18) 0:45 (0:37, 0:54) 

     Moderate 10:39 (9:40, 11:45) 12:25 (11:10, 13:50) 3:01 (2:46, 3:18) 0:45 (0:38, 0:54) 

     High 10:49 (9:45, 12:01) 12:21 (11:00, 13:52) 2:50 (2:35, 3:07) 0:46 (0:38, 0:56) 

Traffic calming     

     Low 10:44 (9:43, 11:52) 12:15 (10:59, 13:41) 2:58 (2:42, 3:15) 0:44 (0:37, 0:53) 

     Moderate 10:37 (9:38, 11:42) 12:22 (11:05, 13:46) 2:51 (2:36, 3:07) 0:44 (0:37, 0:53) 

     High 10:46 (9:43, 11:54) 12:36 (11:16, 14:05) 3:02 (2:46, 3:19) 0:48 (0:40, 0:57) 

Pedestrian infrastructure     

     Low 10:47 (9:46, 11:54) 12:35 (11:17, 14:02) 2:57 (2:42, 3:14) 0:45 (0:37, 0:53) 

     Moderate 10:30 (9:29, 11:37) 12:18 (10:59, 13:46) 2:56 (2:40, 3:13) 0:45 (0:37, 0:54) 

     High 10:51 (9:49, 12:01) 12:21 (11:03, 13:49) 2:58 (2:42, 3:15) 0:47 (0:39, 0:56) 

Note: Data presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, household 

income, education, single/dual parenting, difference from age of peak height velocity, and neighbourhood 

property crime. 
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Table 3.7 Model-adjusted compositional mean by neighbourhood dedicated play and activity spaces. 

Dedicated play and activity 

spaces component 

Sleep  SED  LIPA  MVPA  

Dedicated play and activity spaces index 

     Low 10:48 (9:49, 11:52) 12:22 (11:07, 13:44) 2:56 (2:41, 3:12) 0:45 (0:38, 0:54) 

     Moderate 10:43 (9:43, 11:48) 12:27 (11:12, 13:52) 2:57 (2:42, 3:13) 0:44 (0:37, 0:52) 

     High 10:42 (9:42, 11:49) 12:15 (11:01, 13:39) 2:52 (2:38, 3:08) 0:49 (0:41, 0:58) 

Sport facilities     

     Low 10:47 (9:42, 11:58) 11:54 (10:36, 13:21) 2:54 (2:38, 3:11) 0:49 (0:41, 0:59) 

     Moderate 10:36 (9:38, 11:38) 12:14 (11:02, 13:35) 2:53 (2:39, 3:09) 0:45 (0:38, 0:54) 

     High 10:52 (9:50, 12:00) 12:25 (11:08, 13:51) 2:56 (2:41, 3:13) 0:46 (0:39, 0:56) 

Recreation facilities     

     Low 10:50 (9:50, 11:57) 12:30 (11:14, 13:55) 2:58 (2:43, 3:15) 0:45 (0:37, 0:53) 

     Moderate 10:41 (9:39, 11:47) 12:12 (10:56, 13:36) 2:55 (2:40, 3:11) 0:47 (0:39, 0:56) 

     High 10:43 (9:40, 11:52) 11:50 (10:35, 13:14) 2:51 (2:36, 3:07) 0:49 (0:41, 0:59) 

Note: Data presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, parental 

income, education, single/dual parenting, difference from age of peak height velocity, and neighbourhood 

property crime. 
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Table 3.8 Model-adjusted compositional mean by neighbourhood non-dedicated play and activity spaces. 

Non-dedicated play 

and activity spaces 

component 

Sleep  SED  LIPA  MVPA  

Non-dedicated play and activity spaces index 

     Low 10:47 (9:48, 11:56) 12:23 (11:08, 13:47) 2:54 (2:39, 3:10) * 0:47 (0:39, 0:56) 

     Moderate 10:32 (9:32, 12:11) 12:39 (11:20, 14:07) 3:02 (2:47, 3:20) * 0:46 (0:38, 0:55) 

     High 10:39 (9:41, 11:26) 12:07 (10:55, 13:28) 2:53 (2:39, 3:09) 0:45 (0:37, 0:53) 

Park area     

     Low 10:52 (9:51, 12:00) 12:26 (11:10, 13:51) 2:56 (2:41, 3:12) 0:46 (0:38, 0:55) 

     Moderate 10:45 (9:43, 11:52) 12:18 (11:02, 13:43) 2:58 (2:42, 3:15) 0:46 (0:38, 0:55) 

     High 11:02 (10:00, 12:11) 12:16 (11:01, 13:40) 2:56 (2:41, 3:13) 0:44 (0:37, 0:53) 

Non-park greenspace area 

     Low 11:01 (9:57, 12:11) 12:35 (11:16, 14:03) 2:55 (2:39, 3:12) 0:45 (0:38, 0:54) 

     Moderate 10:53 (9:51, 12:00) 12:21 (11:06, 13:45) 2:55 (2:40, 3:11) 0:45 (0:38, 0:54) 

     High 10:45 (9:44, 11:52) 12:03 (10:50, 13:26) 3:00 (2:44, 3:17) 0:45 (0:38, 0:54) 

Yard size     

     Low 11:00 (9:59, 12:06) 12:08 (10:57, 13:29) 2:58 (2:43, 3:14) 0:48 (0:40, 0:57) * 

     Moderate 10:47 (9:46, 11:56) 12:02 (10:47, 13:25) 2:58 (2:42, 3:15) 0:45 (0:38, 0:54) 

     High 10:51 (9:48, 12:00) 12:49 (11:29, 14:20) 2:54 (2:39, 3:11) 0:42 (0:35, 0:51) * 

Cul-de-sacs     

     Low 11:09 (10:03, 12:20) 12:05 (10:49, 13:30) * 2:59 (2:43, 3:17) 0:46 (0:38, 0:56) 

     Moderate 10:37 (9:40, 11:40) 12:34 (11:20, 13:56) * 2:54 (2:40, 3:10) 0:45 (0:38, 0:53) 

     High 10:54 (9:52, 12:03) 12:25 (11:08, 13:51) 2:56 (2:41, 3:13) 0:44 (0:37, 0:53) 

Note: Groups statistically significant from one another are bolded and include an * symbol. Data are 

presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, parental income, 

education, single/dual parenting, difference from age of peak height velocity, and neighbourhood property 

crime. 
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Table 3.9 Model-adjusted compositional mean by neighbourhood noise factors. 

Noise component Sleep  SED  LIPA  MVPA  

Noise index     

     Low 10:36 (9:35, 11:45) 12:26 (11:06, 13:54) 3:00 (2:44, 3:18) 0:46 (0:38, 0:56) 

     Moderate 10:47 (9:49, 11:49) 12:23 (11:11, 13:44) 2:54 (2:40, 3:10) 0:45 (0:38, 0:53) 

     High 10:40 (9:38, 11:49) 12:09 (10:52, 13:35) 2:58 (2:42, 3:15) 0:49 (0:41, 0:59) 

Ambulance station presence 

     No 10:18 (9:03, 11:45) 12:07 (10:30, 14:01) 2:57 (2:37, 3:19) 0:48 (0:38, 1:01) 

     Yes 10:16 (8:51, 11:54) 12:11 (10:21, 14:22) 2:58 (2:35, 3:23) 0:51 (0:39, 1:07) 

Fire station presence     

     No 9:59 (8:41, 11:28) 12:02 (10:19, 14:02) 2:56 (2:35, 3:19) 0:50 (0:39, 1:04) 

     Yes 10:26 (9:06, 11:58) 12:10 (10:27, 14:09) 2:56 (2:35, 3:19) 0:50 (0:39, 1:04) 

Police station presence 

     No 10:24 (9:13, 11:44) 12:14 (10:42, 13:59) 2:55 (2:37, 3:15) 0:48 (0:39, 1:00) 

     Yes 9:44 (8:15, 11:29) 11:39 (9:42, 14:00) 2:52 (2:28, 3:20) 0:52 (0:38, 1:10) 

Hospital presence     

     No 10:08 (8:54, 11:33) 11:50 (10:15, 13:40) 2:55 (2:36, 3:17) 0:50 (0:39, 1:03) 

     Yes 10:32 (9:05, 12:12) 12:41 (10:47, 14:57) 3:00 (2:38, 3:26) 0:50 (0:38, 1:05) 

Airport presence     

     No 10:14 (9:02, 11:36) 12:06 (10:31, 13:53) 2:58 (2:38, 3:19) 0:49 (0:39, 1:01) 

     Yes 10:02 (8:35, 11:42) 11:57 (10:05, 14:10) 2:52 (2:30, 3:18) 0:51 (0:38, 1:07) 

Freeway presence     

     No 10:31 (9:19, 11:52) 12:17 (10:45, 14:03) 2:47 (2:30, 3:07) 0:50 (0:40, 1:02) 

     Yes 9:33 (8:06, 11:16) 11:23 (9:29, 13:40) 2:54 (2:29, 3:22) 0:51 (0:38, 1:09) 

Railroad presence     

     No 10:01 (8:42, 11:34) 12:08 (10:22, 14:12) 2:59 (2:37, 3:24) 0:51 (0:39, 1:06) 

     Yes 10:10 (8:56, 11:37) 11:47 (10:10, 13:38) 2:49 (2:30, 3:11) 0:49 (0:38, 1:02) 

Traffic volume     

     Low 10:10 (8:50, 11:41) 12:10 (10:25, 14:12) 2:53 (2:32, 3:16) 0:49 (0:38, 1:04) 

     High 10:11 (8:54, 11:38) 11:56 (10:17, 13:49) 2:57 (2:37, 3:20) 0:50 (0:40, 1:04) 

Note: Data presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, parental 

income, education, single/dual parenting, difference from age of peak height velocity, and neighbourhood 

property crime. 
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Table 3.10 Model-adjusted compositional mean by neighbourhood artificial light factors. 

Artificial light 

component 

Sleep  SED  LIPA  MVPA  

Artificial light index     

     Low 10:45 (9:44, 11:51) 12:34 (11:16, 14:01) 2:58 (2:43, 3:15) 0:45 (0:37, 0:54) 

     Moderate 10:50 (9:51, 11:56) 12:18 (11:04, 13:39) 2:59 (2:44, 3:15) 0:46 (0:38, 0:54) 

     High 10:40 (9:41, 11:44) 12:24 (11:08, 13:47) 2:51 (2:37, 3:07) 0:46 (0:39, 0:55) 

Streetlights     

     Low 10:44 (9:44, 11:51) 12:22 (11:06, 13:48) 2:57 (2:42, 3:14) 0:45 (0:37, 0:53) 

     Moderate 10:50 (9:51, 11:56) 12:20 (11:06, 13:43) 2:56 (2:42, 3:13) 0:45 (0:38, 0:54) 

     High 10:48 (9:46, 11:56) 12:19 (11:01, 13:45) 2:57 (2:41, 3:13) 0:46 (0:38, 0:55) 

Commercial buildings 

     Low 10:53 (9:51, 12:02) 12:29 (11:10, 13:57) 3:00 (2:44, 3:17) 0:45 (0:37, 0:54) 

     Moderate 10:47 (9:46, 11:55) 12:07 (10:51, 13:31) 2:55 (2:40, 3:12) 0:46 (0:38, 0:55) 

     High 10:42 (9:44, 11:47) 12:26 (11:11, 13:48) 2:56 (2:41, 3:11) 0:46 (0:38, 0:54) 

Note: Data presented in hours:minutes (95% CI). Adjusted for age, sex, race, season, BMI, parental 

income, education, single/dual parenting, difference from age of peak height velocity, and neighbourhood 

property crime. 
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Table 3.11 Summary table of the associations between neighbourhood physical environment features and 

relative movement behaviours 
Neighbourhood physical 

environment feature  

Sleep  SED  LIPA  MVPA  

Walkability index ↔ ↔ ↔ ↔ 

Connectivity ↔ ↔ ↔ ↔ 

Proximity to destinations ↔ ↔ ↔ ↔ 

Pedestrian safety and 

infrastructure 

↔ ↔ ↔ ↔ 

Traffic safety index ↔ ↔ ↔ ↔ 

Traffic volume ↔ ↔ ↔ ↔ 

Traffic speed ↔ ↔ ↔ ↔ 

Traffic calming ↔ ↔ ↔ ↔ 

Pedestrian infrastructure ↔ ↔ ↔ ↔ 

Dedicated play and 

activity spaces index 

↔ ↔ ↔ ↔ 

Sport facilities ↔ ↔ ↔ ↔ 

Recreation facilities ↔ ↔ ↔ ↔ 

Non-dedicated play and 

activity spaces index 

↔ ↔ ↑ ↔ 

Park area ↔ ↔ ↔ ↔ 

Non-park greenspace area ↔ ↔ ↔ ↔ 

Yard size ↔ ↔ ↔ ↓ 

Cul-de-sacs ↔ ↑ ↔ ↔ 

Noise index ↔ ↔ ↔ ↔ 

Ambulance station 

presence 

↔ ↔ ↔ ↔ 

Fire station presence ↔ ↔ ↔ ↔ 

Police station presence ↔ ↔ ↔ ↔ 

Hospital presence ↔ ↔ ↔ ↔ 

Airport presence ↔ ↔ ↔ ↔ 

Freeway presence ↔ ↔ ↔ ↔ 
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Railroad presence ↔ ↔ ↔ ↔ 

Traffic volume ↔ ↔ ↔ ↔ 

Artificial light index ↔ ↔ ↔ ↔ 

Streetlights ↔ ↔ ↔ ↔ 

Commercial buildings ↔ ↔ ↔ ↔ 

Note: ↑: green upwards arrow indicates a significant positive association; ↓: red downward arrow 

indicates a significant negative association; ↔: sideways arrow indicates null association.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

82 

 

3.5 Discussion 

To our knowledge, this is the first study to use CoDA to examine the associations between 

the neighbourhood environment and movement behaviours. For the most part, the relative 

contributions of individual movement behaviours to the 24-hour day did not differ significantly 

according to neighbourhood physical environment characteristics. The few significant 

differences that did exist (i.e., 3 out of 116 comparisons) were small in magnitude (e.g., 8 

minutes/day of LIPA), did not follow dose-response gradients (e.g., difference between low and 

middle but not high tertile), and were not always in the expected direction (e.g., the low tertile of 

yard space was associated with the most MVPA and the high tertile with the least).  

The lack of significant differences in movement behaviours according to neighbourhood 

physical environment measures was somewhat unexpected since the neighbourhood measures 

considered in our study were drawn from the literature as variables that have been associated 

with movement behaviours. However, there is no consensus within the literature with significant 

heterogeneity in findings across studies. For example, a review that assessed how the 

neigbourhood environment was associated with youth’s physical activity reported that only 31% 

of studies using objectively measured environmental variables observed associations that were in 

the expected direction.39 Another literature review that examined associations between public 

open spaces and adolescent physical activity levels found that the presence of sports fields was 

positively associated with self-reported MVPA in some studies but not with objectively 

measured MVPA in others.40  

One of the reasons for our mostly insignificant findings may reflect the city where the study 

was conducted. Kingston, ON, is a relatively small city with a population of 123,798.41 Most 

previous studies on the neighbourhood environment and movement behaviours have been 
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conducted in large metropolitan areas with a population in excess of 1,000,000 (e.g., Melbourne, 

Toronto, San Diego). These cities likely have much more heterogeneity across neighbourhoods 

and some neighbourhoods that fall further away from the average. To illustrate, consider 

differences in noise caused by traffic volume and emergency services in Kingston and large 

metropolitan areas. The traffic volume on the 401 highway in Kingston, the only expressway that 

runs through the city, averages 55,000 vehicles per day.42 By comparison, sections of the 401 

expressway in Toronto average over 430,000 vehicles per day.43 Neighbourhoods near the 401 in 

Toronto would undoubtedly be more affected by traffic noise than neighbourhoods near the 401 

in Kingston. Further, it is likely that emergency services are much busier and therefore louder in 

in larger cities. For example, using publicly available data we have estimated that the per capita 

number of police stations, hospitals, fire stations, and ambulance stations are 5.8, 4.0, 8.5, and 

4.1 times greater, respectively, in Kingston than in Melbourne.44–47 This implies that a typical 

emergency service station in Kingston serves far fewer people and would therefore have far 

fewer vehicles entering and exiting with sirens blaring.     

Another reason for the lack of significant findings in our study may be that the measured 

movement behaviour characteristics were not specific to the neighbourhood environment 

variables. We categorized movement behaviours according to intensity into sleep, SED, LIPA, 

and MVPA. Alternatively, researchers can categorize physical activity and sedentary behaviour 

into different types or domains. For instance, children can accumulate their physical activity 

through active transportation, outdoor play, curriculum-based physical activity at school, and 

organized sports. Neighbourhood environment variables may influence some of these specific 

types and not others. A study by Rosenberg et al.48 demonstrated that neighbourhood walkability 

was positively associated with youth’s active transportation but not to meeting total physical 
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activity recommendations. This finding points to the idea that total physical activity is influenced 

mainly by non-neighbourhood movement at school and in sport.  

We observed a few significant associations between the neighbourhood environment features 

and non-dedicated play and activity spaces. This observation may reflect that children can spend 

much of their free time outside of school in these spaces. For example, after removing time spent 

at school, children can only devote a small percentage of the remaining time to organized 

activities, so a large chunk of this free time after school and on weekends is spent at or around 

their home. Thus, the amount of time spent outdoors in these areas will influence movement 

behaviours at a greater proportion than, say, walkability or dedicated play spaces. Similar results 

on the effects of these non-dedicated play spaces on movement behaviours have been observed 

in other studies. For example, we found that children in the middle non-dedicated play spaces 

tertile had higher LIPA values. A study using both accelerometers and GPS devices similarly 

found that English children aged 11-12 used all types of park space for all physical activity 

intensities.49 Further, we found that compared to the low tertile, children in the upper cul-de-sac 

tertiles had higher SED values. A study assessing children with the mean age of 9 years found a 

positive association between the number of cul-de-sacs in the neighbourhood and the amount of 

TV viewing (β = 1.3, 95% CI: 0.5, 2.2).50 As for the negative association that we observed 

between yard size and MVPA, Maitland et al.51 stated that even if children have a large yard, it 

may not be sufficient for active play, as type and layout are also important considerations. 

Alternatively, those with the smallest yards may use other neighbourhood amenities for active 

play.51  

The implications of our findings may point to the fact that the neighbourhood physical 

environment is not a key correlate of movement behaviours among children, at least for 
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neighbourhoods in smaller cities such as Kingston, ON. These findings suggest that efforts to 

improve movement in children should be focusing on other factors of the ecological model, such 

as family and school.52,53 In the future, CoDA should continue to be employed in studies looking 

at these other potential correlates of the movement behaviour composition, as such studies are 

lacking as well.  

Key strengths of this study included the objective measures of multiple physical environment 

factors and movement behaviours of the participants, which eliminated the recall bias that occurs 

with self-reported data. Second, there was great care to ensure the data’s completeness and only 

5% of participants were excluded because of missing data. Finally, the study used CoDA 

techniques and considered all intensities of movement across the full 24-hour day.  

This study also had several limitations. First, because this study was cross-sectional causal 

inferences cannot be made. Further, the study lacks generalizability since the sample only 

includes children from Kingston, a narrow age-range of 10-13 years old, and a lack of diversity 

since most of the children were White. Also, although accelerometers provide objective 

measures of movement behaviours, they are not void of limitations. A key limitation of 

accelerometers is that some LIPA (e.g., quiet standing) is incorrectly categorized as SED, 

leading to potential non-differential misclassification.54 This misclassification would result in 

attenuated effect estimates. Further, the 1 km neighbourhood buffer size, based primarily on 

physical activity literature, may not have adequately represented the associations of some of the 

physical environment measures and the other movement behaviours. For instance, light in the 

neighbourhood may only affect the sleep of those who are immediately surrounding the light 

source. Alternatively, noise in the area may come from sources farther than 1 km away from 

each residence. Finally, some of the physical environment constructs such as traffic speed, noise, 
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and light were assessed using proxy measures. Using more direct measures of these 

neighbourhood environment features may have resulted in stronger associations with the 

movement behaviours. 

In conclusion, our study suggests that the neighbourhood physical environment is not an 

important correlate of 24-hour movement behaviours in children. There were some small and 

inconsistent indications of non-dedicated play spaces, such as park space, non-park greenspace, 

yard space, and cul-de-sacs being associated with the movement behaviours of the school-aged 

children and youth more so than any other neighbourhood physical environment exposure 

variable. Future studies should use CoDA to assess other potential correlates of the 24-hour 

movement behaviour composition, including the family and school environments.  
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Chapter 4 

General Discussion 

4.1 Study Summary  

This thesis's objective was to determine if the neighbourhood physical environment's features 

were associated with children's 24-hour movement behaviours relative to one another. I 

accomplished this objective by analyzing data from the Active Play study. The study included 

sociodemographic and movement behaviour data on 458 children, aged 10-13 years old, from 

Kingston, Ontario. Their movement behaviours were measured using accelerometers and sleep 

logs. Neighbourhood physical environment surroundings of the participants were collected using 

a variety of geographic information systems (GIS) software packages and databases. 

Compositional data analysis (CoDA) statistical techniques were used as this allowed me to 

account for the compositional nature of movement behaviour data.  

4.2 Summary of Key Findings 

The key finding was that neighbourhood physical environment features were not important 

correlates of children's 24-hour movement behaviours. Out of 29 associations between relative 

movement behaviours and neighbourhood physical environment features examined, only three 

had significantly different relative times between tertiles of the neighbourhood exposures. These 

three significant associations had small effect sizes (e.g., 6 minutes/day of MVPA), did not 

present dose-response patterns, and were not always in the expected direction. This lack of 

significance suggests that other correlates are more important for determining differences in 

children's 24-hour movement behaviours. 
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Contrary to my findings, many previous studies have identified more consistent, stronger, 

and statistically significant associations between children and adolescents’ movement behaviours 

and features of the neighbourhood physical environment. However, there is substantial variation 

across studies in how the neighbourhood physical characteristics affect movement behaviours. 

For instance, a review of the neigbourhood environment and youth’s physical activity reported 

that only 31% of studies using objectively measured environmental variables observed 

associations that were in the expected direction.1 Moreover, another review on the associations 

between public open spaces and adolescent physical activity levels found that the presence of 

sports fields was positively associated with self-reported MVPA in some studies but not with 

objectively measured MVPA in others.2 This lack of consensus due to differences in participant 

characteristics, measurement, neighbourhood location, among others, may help explain why we 

did not observe strong and consistent associations in the results.  

Expanding on neighbourhood location, a potential reason why my results were mostly null 

could be due to the city in which the study was conducted. The population of many cities 

included in previous studies, such as Melbourne, Toronto, and San Diego, surpass 1,000,000 

people, whereas Kingston, ON, is home to 123,798 people.3 The population density is also much 

lower in Kingston than it is in these more populated metropolitan areas. For instance, in 2016 the 

population density of Toronto was 4,334.4 people per/km2 while the population density of 

Kingston was 274.4 people/km2.4 This difference in population density in the larger cities leads 

to higher traffic volume, more multiple dwelling housing, and higher walk scores due to 

proximity and availability of amenities.5–7 In big cities, there would also be more heterogeneity 

in neighbourhood characteristics from one neighbourhood to another, while Kingston’s 

neighbourhoods are quite homogenous. For example, Kingston’s 40 neighbourhood districts 
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range in population from 600 to 7,235, while Toronto’s 140 neighbourhood districts range from 

6,577 to 65,913 people, demonstrating a much larger variance.3,8  

Additionally, the lack of significant findings may have been due to measuring movement 

behaviours based on intensity rather than specific types of movement known to be influenced by 

the neighbourhood environment, such as outdoor play and active transportation. Measuring the 

movements throughout the entire 24-hour day would inevitably capture activities not affected by 

the participants’ neighbourhood they live in, like curriculum-based physical activity at school or 

organized sports and activities taking place outside the immediate neighbourhood. A study 

demonstrated this issue when they found that youth’s active transportation, but not total physical 

activity level, was positively associated with the neighbourhood’s walkability.9 

4.3 Strengths 

There were several strengths of this thesis. First, the study employed a novel analytic 

technique that properly accounted for the movement behaviour data's compositional nature. It is 

also one of few studies to use CoDA to assess the correlates of movement behaviours, as most 

previous studies have treated the movement composition as the exposure variable to identify 

health outcomes.10 Second, the study included objective measures of the neighbourhood physical 

environment features and the participants' movement behaviours. This removed the potential for 

recall or social desirability bias when using self-reported measures. The sampling strategy for 

this study was also a strength of the study. To minimize the chance for selection bias, the Active 

Play research team used proportional representation across age, sex, season, and electoral district 

when recruiting participants. Finally, the research team also ensured excellent compliance of 

study protocols through daily email and texts to the participants as reminders to wear the 

accelerometers. This practice resulted in only 5% of participants with missing data. Having such 
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a complete dataset decreases potential for sources of selection bias such as low-response rates or 

differential loss to follow-up. 

4.4 Limitations 

The following sections describe the limitations present throughout this thesis.  

4.4.1 Internal Validity 

Internal validity is the extent to which the study’s results represent what is truly going on 

within the overall study population, thus limiting methodological errors.11 Selection bias, 

information bias, and confounding are three common systematic errors that can influence the 

internal validity of the study results. 

4.4.1.1 Selection Bias 

Selection bias refers to issues in the process of selecting and retaining study participants, 

where those chosen to be in the study differ systematically and are not representative of the study 

population.11 In our study that included 458 10-13-year-olds from Kingston, Ontario, selection 

bias could have occurred if the study sample differed from all 10-13-year-olds in Kingston, 

resulting in associations between the exposures and outcomes not reflecting the true associations. 

Volunteer bias is a common type of selection bias. It occurs when the participants who offer 

to take part in the study differ systematically in certain characteristics, such as being more 

health-conscious or having a personal interest in the study.11 This study aimed to avoid volunteer 

bias by recruiting participants to proportionally represent age, sex, season, and electoral districts 

in the city of Kingston, ON; however, participation was still voluntary, which could have 

contributed to some bias. The study’s recruiting team also provided a monetary incentive of $40 

to each participant, which was a main determinant of children’s desire to participate. 
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Another potential source of selection bias is a differential loss to follow-up. This occurs 

when those who remain in the study’s analysis differ from those who dropped out or provided 

insufficient data.11 In our study, only 5% of participants did not have sufficient accelerometer 

data to be included in the final analysis. However, those excluded were more likely to be 13 

years old (p = .021), which may have presented some bias in the results if the older children had 

different relative movement behaviours.  

4.4.1.2 Information Bias 

Flaws in the measurement of exposure or outcome variables can lead to information bias.11 

Information bias, also known as measurement error, can occur due to chance or due to a 

systematic error. A systematic error in the measurement of either the exposure or outcome 

variables can result in a non-differential misclassification or differential misclassification. Non-

differential misclassification in the exposure variable means the measurement error is equal 

across the outcome variable groups. The same misclassification in the outcome variable implies 

the error is identical across the exposure groups. In contrast, differential misclassification in the 

exposure variable is when the error differs across the outcome groups. When it occurs in the 

outcome variable, the error is different across exposure groups.11  

When it comes to measuring the outcome variables of this study, some information bias may 

have occurred. For instance, participants may have participated in physical activity or sedentary 

behaviour while their accelerometer was removed and did not accurately report the non-wear 

time on the log. This would result in underestimations of the amount of activity taking place on 

that day.  

Another cause of information bias would be the accelerometers' potential to incorrectly 

categorize some LIPA as SED.12 For instance, quiet standing, a light intensity activity, would be 
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incorrectly classified as SED. This error would most likely be similar in children living in 

neighbourhoods with different environment features, resulting in non-differential 

misclassification that would attenuate effect estimates. Additionally, accelerometers cannot 

accurately measure non-step-based activities such as swimming and cycling or the energy 

expenditure of primarily upper-body movements like weightlifting. This leads to the potential to 

underestimate physical activity levels.13 Moreover, wearing devices that monitor physical 

activity, such as accelerometers, may cause a reactivity effect. This effect occurs when 

participants, especially children, increase their activity when they are aware it is being 

measured.14 It has been found that this increase in activity is usually only present, or significantly 

different, on the first day of measurement.14 Therefore, in order to combat this issue, the study 

began the seven-day measurement period the day after the visit to the lab when the participants 

started wearing the accelerometer. The participants were also instructed to continue their typical 

weekly activities. Further, no feedback was given to the participant from the accelerometer to 

encourage them to increase their movement. Overall, studies have found minimal to no evidence 

of reactivity when using accelerometers to monitor children's movement behaviours.14,15 

As for the measurement of the study's exposure variables, there is also potential for 

information bias. Although the neighbourhood variables were objectively measured, each 

participant's exposure variables were based on the child's parent-reported home address. This 

would present issues if the child spent time at a secondary address or in another city or 

neighbourhood throughout the data collection period. The potential for differential 

misclassification would arise, causing the result to be biased in either direction, depending on the 

situation. The research team addressed this error as best as possible before starting the study by 
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asking the participant to choose a week to collect data when they would primarily be living at the 

same residence the whole time.  

When collecting neighbourhood physical environment variables in ArcGIS, I used the most 

up-to-date GIS databases available. However, they may not have been updated to accurately 

reflect the actual exposures during movement behaviour data collection. 

Further, the exposure variables were collected based on 1 km neighbourhood buffers based 

primarily on physical activity literature. This may have caused bias in the associations of some of 

the physical environment measures and the other movement behaviours. Light and noise are 

interesting variables, as they may influence movement behaviours at either much smaller or 

much larger buffer sizes. For instance, light may only affect the sleep of those who are 

immediately surrounding the light source. Alternatively, noise may travel from sources farther 

than 1 km away from each residence. Because this would be the case for every participant, this 

would lead to non-differential misclassification, underestimating the actual effects.  

Finally, proxy measures were used to assess physical environment constructs such as traffic 

speed, noise, and light. Using more direct measures of these neighbourhood environment 

features may have resulted in less misclassification and stronger associations with the movement 

behaviours. 

4.4.1.3 Confounding 

Confounding occurs when the relationship of interest is affected by a third factor associated 

with both the exposure and the outcome, but not on the causal pathway.11 We considered 

numerous confounding variables in this study. A series of bivariate analyses were conducted to 

determine which confounding variables would be controlled for in the analysis. Age, sex, race, 

BMI category, difference from age at peak height velocity, season of participation, household 
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income, parental education, number of parents in household, and neighbourhood property crime 

rate were included in the final analyses. However, residual confounding issues may have arisen 

due to measurement error of any of these factors or not including other potential confounders. 

Residual confounding can significantly influence an association between exposure and outcome 

by over or underestimating the effects.16  

4.4.2 External Validity 

External validity, also known as generalizability, is the extent to which the study’s results 

apply to other populations.11 This study sampled children aged 10-13 from Kingston, Ontario. 

Kingston is a mid-sized city with a population of 123,798 people,3 and most of the population are 

White. Generalizability to younger or older children and children living in areas dissimilar to 

Kingston may be lacking. In 2016, 37% of Canadians lived in large municipalities with 

populations greater than 300,000, and about 19% lived in rural areas.17,18 Municipality size and 

demographics of an area can greatly affect the neighbourhood physical environment exposures 

such as traffic volume, walkability, availability of amenities, noise, and light. This sample's age 

may also create generalizability issues, as movement behaviours patterns of children differ from 

young children to school-aged children to adolescents.19–21 

4.5 Causation 

The main objective of this thesis was to determine if relative movement behaviours were 

associated with neighbourhood physical environment features. In epidemiological studies, when 

determining the likelihood of causation in observed significant associations, the five Bradford 

Hill criteria are assessed.22 The following sections discuss the five criteria relating to the 

statistically significant results of the manuscript.  
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4.5.1 Temporality 

Temporality is the only absolute requirement for causation, and it occurs when the exposure 

precedes the outcome.11 Due to the cross-sectional nature of this study, it was not possible to 

establish whether the neighbourhood exposures caused the difference in movement behaviours. 

Reverse causality may be present in the form of “self-selection,” where parents select a 

residential location and physical environment characteristics based on their behavioural 

predispositions.23 Therefore, the exposure may not be influencing the behaviour, but the 

behaviour is influencing the exposure characteristics. This is unlikely in this context as children 

do not select where they live; however, households with children are more likely to have 

residential self-selection preferences than household without children, which may indicate that 

the child’s behaviours and preferences may affect where the family chooses to live.24 

4.5.2 Strength of Association 

The stronger an association is, the less likely the association is due to chance, bias, or 

confounding.11 The three significant associations in my results were not strong associations. For 

example, compared to children living in an area with the least non-dedicated play and activity 

spaces, those living in an area with a moderate amount of these spaces were associated with 

accumulating eight more minutes/day of LIPA. Considering LIPA made up about 3 hours of the 

participants’ days, eight minutes is not a substantial difference.  

4.5.3 Consistency 

Having the same effects or associations as other types of studies and in different populations 

points to consistency among results.11 Since, to my knowledge, no other studies considering how 

the neighbourhood physical environment is related to the 24-hour movement behaviours have 

been conducted, it is hard to assess the consistency of my results. However, as mentioned in 
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Chapter 3, similar findings to my significant results have been observed in other studies 

evaluating individual behaviours. Overall, due to considerable heterogeneity in study methods, 

there is generally a lack of consensus among the literature. 

4.5.4 Dose-Response Relationship 

A dose-response relationship is another criterion of causality that occurs when greater levels 

and duration of exposure increase the outcome's risk or occurrence. In the three significant 

associations between neighbourhood non-dedicated play and activity spaces and the relative 

movement behaviours, two associations did not demonstrate dose-response relationships. For 

instance, in both the non-dedicated play and activity spaces index and cul-de-sacs, those 

participants in the moderate tertile, but not the highest tertile, accumulated the most LIPA and 

SED, respectively.  

4.5.5 Plausibility 

The final criterion for causation is when the relationship inherently “makes sense” based on 

a plausible scientific pathway.11 Regarding the significant result of higher amounts of yard space 

leading to lower relative MVPA, this finding seems to be in the opposite direction of previous 

qualitative studies that have reported small yards as a barrier to physical activity.25-27 As for the 

other two significant relationships, the moderate tertiles of exposures were most significantly 

related to relative movement behaviours rather than low versus high tertiles, contributing to 

doubts in plausibility. Possible reasons these relationships exist include that a greater amount of 

cul-de-sacs in the neighbourhood contribute to lower street connectivity and, therefore, more 

sedentary time due to less active travelling.28 However, this does not explain why the highest 

tertile was not the most significant. When comparing my results to other literature on possible 

mechanisms, the plausibility of the results is low.  
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4.6 Public Health Implications 

This study's public health implications include that modifying features of the neighbourhood 

physical environment in a mid-sized city such as Kingston may not affect 10-13-year-old 

children's relative movement behaviours. However, there is some inconsistent evidence 

suggesting focusing policies and guidelines on increasing the availability of non-dedicated play 

and activity spaces in neighbourhoods. Public health studies and policies should continue to 

assess other ecological model factors, such as the family or school environments, as potential 

correlates of children’s movement behaviours.29,30  

4.7 Future Research Directions 

This study contributed to the growing literature surrounding the neighbourhood 

environment's effects on children's collective movement behaviours. In future studies, this 

relationship should also be studied in different populations, such as larger cities and different 

ages of children, to determine if these results are generalizable beyond this sample. Further, in 

order to determine causation, employing an intervention or longitudinal study design in future 

work would enable establishing any temporality.  

Since this study looked at whole-day movement behaviours, it may be important to 

determine where the children are partaking in their activities using devices such as global 

positioning systems (GPS). This will allow for more context to evaluate if the neighbourhood 

environment's physical features are actually responsible for influencing movement behaviours 

rather than locations outside the neighbourhood or other confounding effects.31  

Finally, continuing to use CoDA when studying other potential ecological model correlates 

of children’s movement behaviours is important. This practice is lacking in the literature, and 
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since the 24-hour movement behaviours are most important for health, continuing to analyze this 

type of compositional data appropriately for other correlates will be needed.  

4.8 Summary of MSc Experience 

Throughout my degree in the School of Kinesiology and Health Studies, I have broadened 

my knowledge in kinesiology and physical activity epidemiology and gained many valuable 

skills and experiences. Starting in my first year, I completed coursework in epidemiology, health 

promotion, and statistics. I also took a critical look at the literature surrounding movement 

behaviours and the neighbourhood physical environment and wrote three literature reviews on 

these topics. Further, throughout my two years as a Masters student, I worked as a teaching 

assistant for six different classes. This exposed me to many exciting concepts and perspectives, 

and I was able to experience facilitating tutorials and marking various types of assignments. 

Outside of courses, I was a member of the Graduate Student Council, the Seminar Series 

Committee, and a volunteer for Kingston Gets Active and Exercise is Medicine, which allowed 

me to serve on councils and get involved in the greater Kingston community. 

During my second year, I dedicated most of my time to writing my proposal, collecting a lot 

of the GIS data used in this thesis, cleaning and analyzing the data, interpreting the results, and 

writing this thesis. I learned how to use ArcGIS software to collect neighbourhood-level data 

from participants in the Active Play study and continued to expand my skills in SPSS. I was also 

able to present my manuscript as a poster at the 20th Annual SKHS Research Colloquium. Apart 

from thesis work, I was also a part of a team that conducted a systematic review of physical 

activity timing throughout the 24-hour day. This opportunity allowed me to learn the process of 

reviewing literature, data extraction, and risk of bias assessment using Covidence software. 
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Through each of these experiences, I have gained skills and knowledge that will prepare me to 

continue working in the field of physical activity epidemiology and public health. 

4.9 Conclusion 

This study used objective measures of both neighbourhood physical environment features 

and children’s 24-hour movement behaviours. Neighbourhood physical environment features 

were not important correlates of children’s relative movement behaviours on their own. 

Continuing to explore the relationships between the neighbourhood environment and other 

aspects of the socio-ecological model and movement behaviours in different populations will be 

necessary. Future studies should continue to apply the statistical analysis technique of CoDA 

when assessing other potential correlates of children’s collective movement behaviours.  
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Appendix A 

Statement of Change 

No significant changes were made from the approved thesis proposal that occurred in August, 

2020.  
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Appendix C 

Example of GIS Count Protocol 
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ArcGIS Protocol for Counting Number of Streetlights Within Neighbourhood Buffers 

 

1. Open ArcMap 
 

2. Open the Streetlights shapefile.   
·  > File > Add Data > Add Data.   

·  Navigate to the following directory:  \\192.168.1.100\Epi Lab\GIS\updated files Jan 2015\????? 

and select the shapefile called ‘Streetlights_UK’.   

·  Click ‘Add’ then ‘Close’.   

·  The buildings should now appear on the map.   

 

3. Open the Neighbourhood Buffer shapefile that contains buffers for all participants.   

·  > File > Add Data > Add data.   
·  Navigate to the following directory:  \\192.168.1.100\Epi Lab\GIS\Neighbourhood  buffers\All 
participants and select the shapefile called ‘neighbourhood_buffers’.   

·  Click ‘Add’ then ‘Close’.   

·   The neighbourhood buffers should now appear on the map.  Zoon into that layer. 
 

4. Join the neighbourhood buffers and streetlights and count the number of streetlights in the buffers.   

·  In the Table of Contents right click the ‘neighbourhood_buffers’ layer.   

·  > Joins and Relates > Join.  

·  Under ‘What do you want …’ select 'Join data from another layer based on spatial location'.  

·  Under ‘Choose the layer…’ select the ‘Streetlights_UK’ layer.  

·  Under the ‘Each polygon will be given…’ option select ‘Sum’.   

·  Change the directory for where the results of the join will be saved to: \\192.168.1.100\Epi 

Lab\GIS\light\ and name the file ‘streetlights_all_counts’. 

·  Click ‘OK’. 

·  It should take <10 sections for the join to complete.  

 

5. Export the attributes table that contains the neighbourhood buffer intersection counts.  

·   > Geoprocessing > ArcToolbox > Conversion Tools > Excel > Table To Excel.   

·  Under ‘Input Table’ select the ‘streetlights_all_counts’ layer.   

·  Under ‘Output Excel File’ change the directory to:  \\192.168.1.100\Epi Lab\GIS\light\ and name 

the file ‘streetlights_all_counts’.  

·  Click ‘OK’.   

 
6. Edit the Excel Table.   

·  Open the ‘streetlights_all_counts’ Excel file created in Step 6.   
·  Change the ‘Count_’ column header to ‘All_Streetlights_Count’.   
·  Change the ‘Name’ column header to ‘Participant_ID’.   
·  Also keep the column ‘Sum_WATTAG’ for the wattage of the lights.  
·  Make sure the file is sorted in ascending order based on the ‘Participant_ID’ column.  
·  Save the edited file.   

 

7.   Complete the same thing but with circular buffers 

·  > File > Add Data > Add data.   

file://///192.168.1.100/Epi%20Lab/GIS/updated
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·  Navigate to the following directory:  \\192.168.1.100\Epi Lab\GIS\Neighbourhood  
buffers\circular neighbourhood buffers and select the shapefile called ‘1km_circle_buffers’.  ·  Click 
‘Add’ then ‘Close’.   
·   The circular neighbourhood buffers should now appear on the map.  Zoon into that layer. 

 

8. Repeat steps 4-6.  

· Change the directory for where the results of the join will be saved to: \\192.168.1.100\Epi 

Lab\GIS\light\ and name the file ‘streetlights_all_counts_circular’ 

·  Rename the ‘Count_’ column header in Excel to ‘All_Streetlights_Circular_Count’ 

 

9. Count Specific Types of Streetlights 

·  > Selection > Select by Attributes.   
·  In the pop-up-box that appears select the ‘Streetlight_UK’ layer.   
·  Double click on the ‘SUBTYPECOD’ field.   
·  Click ‘=’ then click ‘Get Unique Values’.  There will be the numbers 1-4 
· 1= Streetlights; 2= Security Light; 3= Park Light; 4= Parking Lot Light 
· Double click on the ‘1’ option.   
·  Click ‘Apply’.  Click ‘OK’. 
 

10. Create a new layer that contains the preferred Streetlights.   
·  In the Table of Contents, right click on the ‘Streetlight_UK’ layer. 
·  > Data > Export Data.   
·  Change the output directory to: \\192.168.1.100\Epi Lab\GIS\Light\ and name the file 
‘Streetlights_Only’ 
·  Click ‘OK’. Click ‘Yes’. 
 

11. Open the Neighbourhood Buffer shapefile that contains buffers for all participants.   

·  > File > Add Data > Add data.   
·  Navigate to the following directory:  \\192.168.1.100\Epi Lab\GIS\Neighbourhood  buffers\All 
participants and select the shapefile called ‘neighbourhood_buffers’.   
·  Click ‘Add’ then ‘Close’.   
·   The neighbourhood buffers should now appear on the map.  Zoon into that layer. 
 

 

12. Join the neighbourhood buffers and Streetlights and count the number of streetlights only in the 

buffers.   

·  In the Table of Contents right click the ‘neighbourhood_buffers’ layer.   

·  > Joins and Relates > Join.  

·  Under ‘What do you want …’ select 'Join data from another layer based on spatial location'.  

·  Under ‘Choose the layer…’ select the ‘Streetlights_Only’ layer.  

·  Under the ‘Each polygon will be given…’ option select ‘Sum’.   

·  Change the directory for where the results of the join will be saved to: \\192.168.1.100\Epi 

Lab\GIS\Light\ and name the file ‘Streetlights_only_counts’. 

·  Click ‘OK’. 

·  It should take <10 sections for the join to complete.  

 

13. Export the attributes table that contains the neighbourhood buffer streetlights counts.  



 

119 

 

·   > Geoprocessing > ArcToolbox > Conversion Tools > Excel > Table To Excel.   

·  Under ‘Input Table’ select the ‘Streetlights_only_counts’ layer.   

·  Under ‘Output Excel File’ change the directory to:  \\192.168.1.100\Epi Lab\GIS\light\ and name 

the file ‘Streetlights_only_counts’.  

·  Click ‘OK’.   

 
14. Edit the Excel Table.   

·  Open the ‘Streetlights_only_counts’ Excel file created in Step 13.   
·  Change the ‘Count_’ column header to ‘Only_Streetlights_Count’.   
·  Change the ‘Name’ column header to ‘Partcipant_ID’.   
·  Also keep the column ‘Sum_WATTAG’ for the wattage of the lights  
·  Make sure the file is sorted in ascending order based on the ‘Partcipant_ID’ column.  
·  Save the edited file.   
 

15. Repeat for each type of Streetlight and also the same with the circular buffers.  
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Appendix D 

Example of GIS Distance Protocol 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

121 

 

ArcGIS Protocol for Calculating Freeway Distances Within Circular Neighbourhood 

Buffers 

 

1. Open ArcMap 
 

2. Open the City of Kingston road segments file.   
·  > File > Add Data > Add Data.   
·  Navigate to the following directory:  \\192.168.1.100\Epi Lab\GIS\updated GIS files Jan 
2017\Road_Segment and select the shapefile called ‘Road_Segment’.   
·  Once the file is selected, click ‘Add’.   
·  The road segments should now appear on the map. 

 
3. Open the Circular Neighbourhood Buffers for Group 1.   

·  > File > Add Data > Add data.   
·  Navigate to the following directory:  \GIS Data\circular neighbourhood 
buffers\Groups_circular_buffers and select the shapefile called ‘Group1_buffers’.   
·  Once the file is selected, click ‘Add’ then ‘Close’.  
·  The circular neighbourhood buffers for Group 1 should now appear on the map. 

 

4. Clip the road segments that are within the circular neighbourhood buffers.  

·  > Geoprocessing > Clip.   

·  Under ‘Input Features’ select the ‘Road_Segment’ layer.   

·  Under ‘Clip Features’ select the ‘Group1_buffers’ layer.  

·  Under ‘Output Feature Class’ change to the following directory: \GIS Data\Data Collection\Road 

Distances and name the file ‘Group1_circ_clipped’   

·  Leave the ‘XY tolerance’ option empty.   

·  Click ‘OK’ 

 

5. Remove the complete road segment layer.   

·  In the Table of Contents, right click on the ‘Road_Segment’ layer.   

·  > Remove. 

 

6. Calculate the length of each road segment in the clipped layer.   

·  Go to the Editor Toolbar.  > Editor  > Start Editing.   

·  In the pop-up-box select the ‘Group1_circ_clipped’ layer.  Click ‘OK’.   

·  In the Table of Contents, right click on the ‘Group1_circ_clipped’ layer.   

·  > Open Attribute Table.   

·  Select the ‘Length’ column by left-clicking the title cell (it will be highlighted in blue if it is 

selected).   

·  Right click and select ‘Calculate geometry.’   

·  Ensure that it is set to ‘Use coordinate system of the data source’ and units as ‘Meters [m]’.   

·  Click ‘OK’.   

·  The length of each individual segment of road contained within the clipped buffers has been 

calculated.  Note that this will override the previous length calculations, which included the length of 

roads both inside and outside of the clipped buffers.    

·  Go to the Editor toolbar.  > Editor > Save Edits.  Editor > Stop Editing.   

 

file://///192.168.1.100/Epi%20Lab/GIS/updated
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/all%20roads/
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/all%20roads/
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7. Select ‘freeway’ roads in the clipped layer.  

·  > Selection > Select by Attributes.   

·  For ‘Layer’ select ‘Group1_circ_clipped’.    

·  In the ‘SELECT * FROM…’ box enter: ORN_CLASS = ‘FREEWAY’.   

·  Click ‘Apply’.  Click ‘OK’.   

·  In the Table of Contents, right click on the ‘Group1_circ_clipped’.   

·  > Data > Export Data 

·  Click ‘OK’. Click ‘Yes’. 

 

8.  Determine the length of ‘freeway’ roads in each buffer.   

·  In the Table of Contents, right click the ‘Group1_buffers’ layer.  > Joins and Relates > Join.  

·  Under ‘What do you want …’ select 'Join data from another layer based on spatial location'.  

·  Under ‘Choose the layer…’ select the ‘Export_Output’ layer.  

·  Under the ‘Each polygon will be given…’ option select ‘Sum’.   

·  Change the directory name to: \GIS Data\Data Collection\Road Distances\ and name the file 

‘Group1_circ_freeway_length’.   

·  Click ‘OK’.   

·  It will take a few seconds for the join to complete. 

 

9. Export the attributes table that contains the neighbourhood buffer local road length calculations.   

·  > Geoprocessing > ArcToolbox > Conversion Tools > Excel > Table To Excel.   

·  Under ‘Input Table’ select the ‘Group1_circ_freeway_length’ layer.   

·  Under ‘Output Excel File’ change the directory to:  \GIS Data\Data Collection\Road Distances\ 

and name the excel file ‘Group1_circ_freeway_length’.   

·  Click ‘OK’.   

 

10. Edit the excel files.   

·  Open the ‘Group1_circ_freeway_length’  excel file located in the following directory: \GIS 

Data\Data Collection\Road Distances\.   

·  Keep the header of the ‘Participan’ column. 

·  Change the header of the ‘Sum_Length’ Column to ‘Freeway_Length’.   

·  Delete all of the remaining columns.   

·  Make sure the file is sorted in ascending order by the ‘Participan’ column before saving the 

changes.   

 

11. Repeat Steps 1 to 10 for all remaining groups with non-intersected neighbourhood buffer 

boundaries.   

 

12. Merge the Excel files for all groups into a single excel file.   

·  Call this file ‘Freeway lengths for all participants’ and place it in the following directory: \GIS 

Data\Data Collection\Road Distances\ 

 

 

 

  

file://///192.168.1.100/Epi%20Lab/GIS/road%20length/all%20roads/%20and%20name%20the%20file%20
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/all%20roads/%20and%20name%20the%20file%20
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/Excel%20files/
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/Excel%20files/
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/Excel%20files/
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/Excel%20files/
file://///192.168.1.100/Epi%20Lab/GIS/road%20length/Excel%20files/
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Appendix E 

Example of GIS Area Protocol 
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ArcGIS Protocol for Determining Area of Residential Properties, Buildings, and Average 

Yard Size Within Neighbourhood Buffers 

1. Open ArcMap 

2. Open the Residential_Properties_Counts shapefile 

a. >File>Add Data> C:\Users\Julie\Documents\GIS Data\Data 

Collection\Buildings,Properties\ 

3. Export the attributes table that contains the neighbourhood buffer residential properties counts.  

·   > Geoprocessing > ArcToolbox > Conversion Tools > Excel > Table To Excel.   

·  Under ‘Input Table’ select the ‘residential_properties_counts’ layer.   

·  Under ‘Output Excel File’ change the directory to:  C:\Users\Julie\Documents\GIS 

Data\Data Collection\Buildings,Properties and name the file 

‘residential_properties_areas’.  

·  Click ‘OK’.   

4. Edit the Excel Table.   

·  Open the ‘residential_properties_areas’ Excel file created in Step 5.   

·  Change the ‘Sum_Shap_4’ column header to ‘Residential_Properties_Area’.   

·  Change the ‘Name’ column header to ‘Participant_ID’.   

·  Delete all of the other columns.   

·  Make sure the file is sorted in ascending order based on the ‘Participant_ID’ column.  

·  Save the edited file.   

*Note* Many participants did not live on “residential_properties”, so in order to capture more properties, 

another residential file was used and the same process above was repeated (Residential_Land) 

Original File>GIS Data>cityofkingston_May2013.gdb>Residential_Land 

-Open “residential_land_areas” in GIS Data>Data Collection>Buildings, Properties. This was created 

through the protocol “ArcGIS Protocol for Counting Number of Residential Properties Within 

Neighbourhood Buffers”. Repeat Step 4 from here.  

*For finding Residential Building Area, refer to Protocol Sheet “ArcGIS Protocol for Counting Number 

of Residential Buildings Within Neighbourhood Buffers”  

*This same attribute table/excel sheet will have a column named “Sum_Shap_1” Which should be 

renamed to “Residential_Buildings_Area”.  

 

Average Yard Size Calculation 

-average yard size is determined through the equation: 

 [area of residential property – area of residential buildings] / number of residential properties 

-Because both residential_properties and residential_land areas were found, the larger of the two for each 

buffer was selected by finding the maximum of the two as it most closely represented the actual area. The 

corresponding count of residential properties for the maximum area was manually noted and selected into 

the “Final_Residential_Count” column.   

-all residential data on properties and buildings can be found in excel file “All Residential Data” in GIS 

Data>Data Collection>Buildings,Properties  

-“Final_Residential_Property_Area” column in “All Residential Data” file refers to the maximum or 

either the residential_properties_areas or residential_land_areas. “Final_Residential_Count” refers to the 

corresponding property count for the maximum area in each buffer.  

-Average Yard Size was calculated with the final equation: 

[Final_Residential_Property_Area – Residential_Building_Areas] / Final_Residential_Count 
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Appendix F 

Activity Monitor and Sleep & Activity Log Instructions 
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Instructions for Activity Monitor, Location Monitor, and Sleep & Activity 

Log 

 

This study will measure your physical activity patterns over one week.  In order to do this, we 

want you to wear an Activity Monitor and a Location Monitor for the next 7 days.  We are 

interested in measuring your normal activity level.  Please do not change your normal physical 

activity levels during the study. 

 

             Picture of the Activity Monitor              Picture of the Location 

Monitor 

 

 

 

 

 

 

 

 

 

 

Information and Instructions for the Activity Monitor and Sleep & Activity Log 

 

An Activity Monitor is a small electronic device that records all daily activities as electronic 

signals. It does not need to be turned on or off.  You do not need to change the batteries or 

recharge this device.  Please start wearing the Activity Monitor as soon as your visit to the 

laboratory is over.  We want you to keep wearing it for the 7 days and nights following your 

visit.   
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The Activity Monitor should be worn as shown in the picture to the right.  You should 

wear it around your waist using the elastic belt we give you.  It should be worn above 

your right hip.  The Active Monitor should be positioned so that “RESPIRONICS” is at 

the top and “Actical” is at the bottom.  It should be located half way between your 

stomach and back.  You can wear it underneath or above your clothes. 

 

It is very important that you wear the Activity Monitor as much as possible. You 

should take it off when you are having a bath or shower or when swimming since the 

Activity Monitor is not waterproof.  If there are times that you need to take the 

Activity Monitor off, other than when having a bath or shower, we would like you to 

record this on the Activity Monitor and Location Monitor Diary.  This should be recorded in 

the PINK columns of the diary. 

 

We would also like you to keep the Activity Monitor on at night when you go to bed.  The 

Activity Monitor will measure how much you move when you are sleeping.  We would like you 

to record what time you wake up in the morning and what time you go to bed at night on the 

Sleep, Organized Sports, and Outside Chores Diary. This should be recorded in the YELLOW 

columns of the diary. 

 

If you participate in organized sports or programs during the study (eg, hockey, soccer, karate, 

dance class), we would like you to record these sports and the times you participated in the 

Sleep, Organized Sport, and Outside Chores Diary. This should be done in the GREEN 

columns of the diary.  Finally, if you do any chores or work outdoors during the study (eg, 

shovel snow, farming, cut grass), we would like you to record what time you did this work in 

the BLUE columns of the diary.  

 

  

 



 

128 

 

Appendix G 

Activity Monitor Diary 
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   Participant ID: _____________________                   Todays Date (day/month/year): ______________________ 

 

 

 

 

 

Day 

If you took the Activity Monitor 

off, what time did you take it 

off and put it back on? 

What were you 

doing when the 

Activity Monitor 

was off? 

If you left home without the 

Location Monitor, what time did 

you leave and come back home? 

Where did you go 

without the Location 

Monitor? 

Time Off Time Back On Time Left 

Home 

Time Came 

Back Home 

 

Example  
4:00 pm 4:30 pm karate 3:45 pm 4:45 pm Kingston Karate Club 

6:30 pm 7:30 pm soccer    
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Day 1       

 

Day 2 

      

      

      

 

Day 3 

      

      

      

 

Day 4 

      

      

      

 

Day 5 

      

      

      

 

Day 6 

      

      

      

Day 7 
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Appendix H 

Sleep Log 
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   Participant ID: _____________________                   Todays Date (day/month/year): ______________________ 

 

 

 

 

 

 

 

Day 

What 
time did 
you get 
out of 
bed in 

the 
morning? 

What 
time did 
you go to 
sleep at 
night? 

If you participated in 

organized sports or programs, 

what time did they start and 

stop? 

What organized 

sports or programs 

did you participate in? 

If you worked or did 

chores outside, what time 

did they start and stop? 

Time Start Time Stop Time Start Time Stop 

 

Example 

 

7:30 am 

 

9:30 pm 

4:00 pm 4:30 pm karate 7:50 am 8:10 am 

6:30 pm 7:30 pm soccer   

     

 

Day 1 
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Day 2 

       

     

     

 

Day 3 

       

     

     

 

Day 4 

       

     

     

 

Day 5 

       

     

     

 

Day 6 

       

     

     

Day 7 

       

     

     

 

 

 

 

 

 

 

 


